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Signet 4630 Free Chlorine Analyzer System
Signet 4632 Chlorine Dioxide Analyzer System

3-4630.090 RevM 04/15

Operating Instructions

The Signet 4630 and 4632 Systems are EPA 334.0 Compliant.

The Signet Chlorine Analyzer Systems are integrated, all-in-one chlorine panel systems
designed to measure Free Chlorine or Chlorine Dioxide in drinking water and clean, fresh
water treatment applications.

This manual includes the 4630 Free Chlorine and 4632 Chlorine Dioxide Analyzer Systems.

Features:

* EPA 334.0 Compliant: The 4630 Free Chlorine and 4632 Chlorine Dioxide systems can
be used for reporting chlorine residuals in accordance with EPA Method 334.0.

» Complete chlorine analyzer system allows quick setup and easy installation. Connect
to a water source and plug it in.

» Unique integrated clear flow cell combines sensors, flow regulator, filter and variable
area flow indicator in one compact unit.

« Built-in variable area flow indicator facilitates flow rate confirmation at a glance.

* Integrated flow regulator with removable filter accepts inlet pressures of 1 to 8 bar
(15 to 120 psi) while maintaining constant flow and minimal pressure to the sensors.

» Water flows vertically into sensor tip, eliminating bubble entrapment. Raised exit in flow
cell sensor chamber ensures sensors stay submerged even when system and flow is
turned off.

* Flow cell accommodates two sensors; one chlorine and an optional pH sensor.

» Automatic pH and temperature compensation or manual pH value input capability for
accurate free chlorine readings.

» Easy viewing of the transmitter via the bright backlit LCD display.

Moisture-proof NEMA 4X wiring enclosure.

Additional information can be found in the individual product manuals,
refer to www.gfsignet.com.
Click on Product Manuals under the Signet Quick Links section.

Safety

English
Deutsch
Francais ACAUTION!

Espaiiol
1. Follow instructions carefully to avoid personal injury.

2. Do not exceed the maximum pressure or temperature specifications.

3. Mounting the Chlorine System in an outdoor box, in areas with elevated temperatures,
may cause damage to the system if the enclosure's internal temperature exceeds the
temperature specification of the Chlorine Analyzer.

. Do not alter product construction.

. For use with clean fresh water only.

. Disconnect AC power before opening wiring enclosure.

. This panel system uses AC voltages. Wiring should be done by qualified personnel only.
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http://www.gfps.com/content/gfps/country_US/en_US/markets/automation/measurement.html#par_link_list_41ab

Warranty Information

Refer to your local Georg Fischer Sales office for the most
current warranty statement.

All warranty and non-warranty repairs being returned must
include a fully completed Service Form and goods must be
returned to your local GF Sales office or distributor.
Product returned without a Service Form may not be
warranty replaced or repaired.

Signet products with limited shelf-life (e.g. pH, ORP, chlorine
electrodes, calibration solutions; e.g. pH buffers, turbidity
standards or other solutions) are warranted out of box but not
warranted against any damage, due to process or application
failures (e.g. high temperature, chemical poisoning, dry-out)
or mishandling (e.g. broken glass, damaged membrane,
freezing and/or extreme temperatures).

Product Registration

Thank you for purchasing the Signet line of Georg Fischer
measurement products.
If you would like to register your product(s), you can now
register online in one of the following ways:

* Visit our website www.gfsignet.com and

click on Product Registration Form
« If this is a pdf manual (digital copy), click here
+ Scan the QR Code on the left

Safety Information

Table of Contents

DESCHPLON ..ot 1
Warranty Information..............ccooeiiieniiir e 2
Product Registration ............ccoooiiiiiii 2
Safety Information............cccoveeiiiiie e 2
Chlorine System DIimensions...........ccocvveerereerrsieene e 3
Chlorine System Specifications ............ccoocvvieiiiieenirieee 3
4630 Chlorine Analyzer System Inventory............ccccceveverennenne 4
(@ U1 Q] =Ty SRS 4
Panel ASSemMDIY........cooiiiiii e 5
Component Identification: Flow Cell..........cc.ccoveiviieiiiiieenens 6
MOUNEING . e 7
WIING INPUL ..o 8

WIirNG OULPUL ...
Electrical Box Wiring Schematic.........c.ccoovvieiiiieniniiieee
Chlorine Sensor Preparation ...........ccccceeiieiieiceecic e
Chlorine Sensor Calibration............cccooveeeieeieriiiereeeceens
Chlorine Sensor Maintenance ............cccccceeeeee.
Sensor Installation.............ccooeeeerviennne.
Tubing Connections .........c.cccooveienvecenienne
Water FIOW ......ccoooieiiiiiiiee
8630 Chlorine Transmitter...............cc........
View Mode........coooiiiiiiiiiiiieeeeee
Editing Procedure...........cccoooeviiiienenn.
Calibrate MeNU .........cccoiiiiiiiieesee e
OpioNS MENU ..ot
Chlorine Sensor Conditioning ...........cccovvevieiceesee e
pH Sensor Calibration...........cccocoieiiiiiiiiiece e
Chlorine Sensor Calibration ............ccoccovveeiiiiieneneeen
Output Settings - Loops and Relays
2650-7 DryLoc® Amperometric and 2750-7 pH Electronics ... 28

Wiring to the Signet 8630 Chlorine Transmitter................. 28
Warning / Caution / Danger Chlorine Electrode OVerview ............ccccovireneniencneneeneen 29
A Indicates a potential hazard. Failure to follow all warnings 2630 and 2632 Amperometric Chlorine Electrodes........... 29
may lead to equipment damage, injury, or death Calibration .........ccceeeiiee e 30
Electrostatic Discharge (ESD) | Electrocution Danger Ma|ntenance ....................................................................... 30
Alerts user to risk of potential damage to product by ESD, 2724 DryLoc pH Electrode.........cccoooiiieiiieiieeeeeeee 31
and/or risk of potential of injury or death via electrocution. Calibration .........ccceeiiiee e 32
A | Personal Protective Equipment (PPE) Appendix ................................................................................ 33
;[b Always utilize the most appropriate PPE during Maintenance - 463X Chlorine Analyzer Flow Cell ............. 33
- installation and service of Signet products. Maintenance - 2630 Free Cl / 2632 CIO, Electrode.......... 36
\\ *ﬁj‘/ Pressurized System Warning Malntenance.- 2724 DryLoc p.H Electrode........cccocvevvennne. 38
182/ | sensor may be under pressure, take caution to vent Troubleshoot!ng - 463X ChIor'lne Analyzgr ........................ 39
& ZF | system prior to installation or removal. Failure to do so Troubleshooting - 8630 Chlorine Transmitter .................... 40
==""== | may result in equipment damage and/or serious injury. 8630 Transmitter Error Messages..........cccoveveveveueevevevevennnns 41
Hand Tiahten Onl Troubleshooting - 2630 Free Cl / 2632 CIO, Electrode..... 43
and Tighten Only . .
Qmﬁj Overtightening may permanently damage product Troltfble.shootlng - 2750-7 pH Electronics.......ccccccccvveeinennn. 43
threads and lead to failure of the retaining nut. SpPecifications ..o 44
Ordering INformation ...........c.coeoeeieiiieee e 48
Do Not Use Tools
Use of tool(s) may damage product beyond repair and
potentially void product warranty.
! Note / Technical Notes
Highlights additional information or detailed procedure.
Do Not Freeze
Products are temperature sensitive and may contain
— freezable liquids. Freezing damage to pH, ORP, and
Peeeoe | | Chiorine electrodes voids product warranty.
463X Chlorine Systems Manual +GF+


http://www.gfps.com/content/gfps/country_US/en_US/service_and_support/registration.html

165 mm
IF (6.5in.)
d_

578 mm (22.75 in.)

=
[l

b T
79.3 mm (3.121in.)
v

l«—— 305 mm (12in.) —>]

Eﬁ;
ke [«— 254 mm (10in.) —>|
oo

B2 )

T Hand Holds

£

€ 25 mm
§ I (1.0in.)

g 7 mm
(0.27in.)
yr'd

T 14 o

. \ g 13 mm
£ (0.52iin.)
w

S

£

£

s

v

7Y 1

Material Safety Data Sheets (MSDS) are available online
at www.gfsignet.com.

Specifications

General
Compatible Signet Sensors:

* 3-2630-1 Free Chlorine Sensor 0-2 ppm

» 3-2630-2 Free Chlorine Sensor 0-5 ppm

» 3-2630-3 Free Chlorine Sensor 0-20 ppm

» 3-2632-1 Chlorine Dioxide Electrode 0-2 ppm
3-2724-00 Flat pH Electrode

Materials:

Panel: ... Black acrylic

Flow Celli.....oooiiiiiiiiiiiiic Acrylic

Wiring Enclosure: ..................... Polycarbonate

Wetted Materials:

Flow cell, spacer rings:............. Acrylic

Flow regulator housing.............. Polycarbonate

Strainer, e-clip, regulator spring,

float: .o Stainless steel

Valves, vent: ... Polypropylene

Flow cell O-rings, diaphragm:...EPDM, FKM

Chlorine electrode .................... PVC, PVDF or PTFE, FPM

pH electrode ...........ccccvveeeeenn, PPS, Glass, UHMW, PE, FPM

Sealing tape (valves, plug, vent)..PTFE

PlUg .ooooiiiie Polyethylene

Performance

System Inlet Pressure Rating:..1 to 8 bar (15 to 120 psi)

Pressure Regulator................... < 0.69 bar (10 psi) variation
over all ranges of flow and
pressure

Flow tolerance ...........cccccceeennnins +15% or rated specification
above

Flow rate limits.........ccccoeveinene. 8 to 12 gph (US)
(30.24 to 45.36 LPH)

Electrical

AC Input (standard): ................. 100 to 240 VAC nominal
50 to 60 Hz, 0.17 Aat 100 VAC

DC Input (optional): .......c............ 12 to 24 VDC +£10% regulated,

10 W, 250 mA max
Environmental Requirements

Storage Temperature:............... 0°C 1065 °C (32 °F to 149 °F)
Operating Temperature:............ 0°Cto45°C (32 °Fto 113 °F)
Relative Humidity:..................... 0 to 95%

Maximum Altitude: .................... 2000 m (6562 ft)

Shipping Weight: ..........cccceene 10 kg (22 Ibs)
Enclosure:........ccccciiiiiiiienns NEMA 4X (with output wire

glands sealed)

Standards and Approvals
« CE, UL, CUL, WEEE
* RoHS Compliant
* Manufactured under ISO 9001 for Quality,
ISO 14001 for Environmental Management and
OHSAS 18001 for occupational health and safety.

% China RoHS (Go to www.gfsignet.com for details)

F€ Declaration of Conformity according to FCC Part 15
This device complies with Part 15 of the FCC rules.
Operation is subject to the following two conditions:

(1) This device may not cause harmful interference, and,
(2) This device must accept any interference received,
including interference that may cause undesired operation.
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System Inventory

1. Chlorine panel assembly
a. Built-in pressure regulator 15 to 120 psi.
b. 3/8 inch hose barb connectors.
2. 1 each 2630 series Free Chlorine sensor or 2632 Chlorine Dioxide sensor; each with protective cap
a. 1 spare membrane cap
b. 2 bottles of electrolyte solution
c. 1 syringe needle (taped to bottle)
d. 1 syringe
1 each Flat pH sensor 3-2724-00 (159 001 545) (3-4630-11, -21, -31 and 3-4632-11 models only)
4. Manual package
a. English panel assembly manual
b. CD with multi-language manuals
c. Wall mounting hardware
d. Drill template
5. 1 each North American Type B power cord
6. Customer supplied
a. 3/8" hose input and drain
b. Hose clamps

Follow the steps below to set up a new Chlorine Analyzer System. Refer to the individual component manuals for detailed information.

Step 1. Mount the panel on a vertical flat surface using appropriate hardware.

A Do not turn on power at this time.

Step 2. Open the wiring enclosure and wire input power
(see page 8: Wiring Input, page 9: Wiring Output, and page 10: Electrcial Box Wiring Schematic).
Step 3. Wire any 4 to 20 mA and relay output.

Step 4. Remove sensor access plugs from the flow cell (Figure 1).
If the optional pH sensor is NOT used, do not remove the left-side plug from the flow cell.

Step 5. Remove the protective cap from the chlorine electrode.
(Keep the electrode cap in a safe place for future use. It is recommended to use the cap to protect the sensor during
the removal of the electrode for cleaning or maintenance of the flow cell).

Step 6. Complete Sensor Preparation (see page 11) and install the chlorine sensor into the electronics
(see page 12: Sensor Installation). Install the chlorine electrode into the flow cell.
The chlorine sensor is installed in the right-side access port, optional pH sensor is installed in the left-side access port.
NOTE: All new chlorine and pH sensors require calibration during the start up of a system and throughout the life of the sensor.
A new chlorine sensor requires a conditioning period of up to 4 hours with power on and chlorinated water flowing past
the sensor prior to calibration. See page 24: Chlorine Sensor Calibration, for chlorine calibration and set up procedure.
NOTE: |If a Free Chlorine sensor without optional pH sensor is used, pH value must be
"hard-coded" into the system (See page 23: Manual pH compensation).
If optional pH sensor is installed, see page 22 to complete pH Sensor Calibration.
Step 7. Repeat step 5 and 6 if the optional pH sensor is being used.
Step 8. Install the influent water source to the "Inlet Port" nipple assembly of the flow Sensor access plugs
cell. Install 3/8-inch tubing and secure with a hose clamp.
(Not included. See page 13: Tubing Connections)
Step 9. Install 3/8-inch tubing and secure with a hose clamp on the "Drain" port and
direct the tube to a proper drain. (Not included)
Step 10. Verify the inlet and drain ball valves are in the open position and
the sample port is in the off position (See page 13: Tubing Connections).

Step 11. Turn on the influent water source and check the system for leaks.

Step 12. Apply power to the system and allow system to initialize. Calibrate per
instructions Figure 1
(See page 24: Chlorine Sensor Calibration and page 22: pH Sensor Calibration).

NOTE: As factory default, the 4630-X Chlorine Panel Assembly is set to measure Free Chlorine. If a 2632 Chlorine Dioxide
sensor is to be used to convert to a Chlorine Dioxide Panel Assembly, refer to the 8630-3 OPTIONS Menu on page 20.
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Panel Assembly

(A

Power cable conduit —

pH sensor

electronics
3-2750-7 (159 001 671)

Wiring enclosure

Transmitter
3-8630-3P (159 001 673)

— Output conduits

Amperometric chlorine

sensor electronics
3-2650-7 (159 001 670)

Chlorine electrode

pH electrode
3-2724-00 (159 001 545)

|
Flow range limits 4 |

Flow rate indicator —————=-|

3-2630-X (Free Chlorine)
3-2632-1 (Chlorine Dioxide)

—— Flow cell block

Flow cell O-rings

Flow regulator with strainer

@

Inlet port —M8M8

Quick disconnect
2000-2525*

Quick disconnect plug

(3/8 inch hose)
2000-3825*

o
A

il
o1

Q l|!

Drain port

(3/8 inch hose)

3/8" Ball valve

4300-5225*

3/8" Hose barb

2000-3804*

Sampling port

* Contact factory for quote
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Component Identification: Flow Cell

Flow cell nut

Flat washer

— Flow cell back block

&——» —— Spacerring

; ] Regulator Assembly
«as—— Stainless steel filter
(3-4630.391)
(159 001 689)
Pressure regulator

©— Pressure regulator outer O-ring (large) | Fiow Cell

G = lat ter O-ri I Rebuild Kit
ressure regulator outer O-ring (small) (3-4630.390) | 3-4630.392
Flow cell O-rings (4 segments) (159001 688) | (159001 690)

Flow cell front block

-
— -—
— o= S "
= : Flat washer
= - v
€ — S - <=—— Disc spring (2700-0003)*
- S g— Knurled thumb nut (1700-2512)*
—
Flow cell bolt (2490-0554)
*Not included with
3-4630.392 (159 001 690)
Included in kit 3-4630.390
Item Quantity
Flow cell nut 6
Flat washer Flat washer 15
Disc spring (curved washer) Disc spring 9
Knurled thumb nut 3
Flow cell bolt 6

463X Chlorine Systems Manual +GF+



A Do not mount in direct sunlight.

= Bright light can promote algae growth. Indoor mounting is recommended.

« If the system is mounted outdoors, an outdoor enclosure for the whole system must be
used to protect the electronics and flow cell from light, rodents, insects and dirt.

» Mount the panel according to local electrical, building, and/or plumbing codes and
seismic requirements.

» Use four 6 mm (%4 in.) diameter screws or bolts of sufficient length to mount the panel to
a sturdy vertical surface. A mounting template is provided.

» Allow clearance on the sides and bottom for service to the unit.
» Keep panel system electronics and enclosure away from dripping water.
» The panel must be mounted vertically in an upright position.

+GF+ 463X Chlorine Systems Manual



Power Supply Terminal Identification

Terminal | Name Description

V. ADJ Voltage Adjusts within £10%; turning clockwise
adjustment | increases output voltage

DC ON Operation Green LED is lit when output voltage
indicator ison

+V, -V DC output +V: Positive output terminal
terminals —-V: Negative output terminal

L,N Input Accepts a wide range of voltages and
terminals frequencies (100 to 240 VAC DC input)

100 to 240 VAC input
Standard AC configuration

Input for
100-240 VAC

o
N

v

& /
.%ﬁs
A

Figure 3

Figure 4

WARNING

This panel system is
wired for AC voltages _ g
that can injure or kill. ___g@
Wiring should be performed by .
qualified personnel only.
Disconnect AC power before opening wiring enclosure.

Follow all local and government recommendations and
methods for installation of electrical connections to and
between the system and other devices.

System Input Power

* The panel system is pre-wired with an auto switching power
supply that is rated for 100 to 240 VAC 50/60 Hz input.

» Wire with NEC Class |, 300 volt, 105 C wire.

» A switch or circuit breaker rated at 15 amps AC shall be
included in the building installation.

« Install the circuit breaker in close proximity to the
equipment and within easy reach of the operator.

* Mark the circuit breaker as the disconnecting device for
the equipment.

» Grounding: The protective ground terminal must be
bonded to protective earth in the host equipment.

Part # 7300-0024 (159 001 693) shown.
Actual power supply may differ from Figure 2.

100 to 240 VAC Input Wiring

» Open the electrical box by loosening the four corner
screws of the front cover.

« Insert input power wiring into the pre-drilled access hole
on the left side of the electrical box using appropriate
conduit adapters to maintain the Type 4X rating. (Supplied
conduit connectors may have to be removed.)

« Install the input power wires into the proper terminals
on the power supply (Figure 2). Use only 12 to 26 AWG
copper wiring.

» Recommended torque for the terminals is 7 Ib-in.

NOTE: When using alternate power supply
7300-7524 (159 000 687):
» Use 10-24 AWG copper wiring, 105 °C, torque 4.4 Ib-in.

12 to 24 VDC Input Wiring Conversion

« If the power source supplied to the system will be 12 to
24 VVDC instead of 100 to 240 VAC, disconnect the red
and black output wires from the power supply (Figure 3)
and connect your UL approved limited-energy DC power
supply (Figure 4), using an insulated nylon parallel splice
connector such as T&B part number 2C-12 or equivalent.

* Insert input power wiring into the pre-drilled access hole
on the left side of the electrical box using the appropriate
conduit adapters to maintain the Type 4X rating.
(Customer may have to remove the supplied conduit
connectors.)

» A switch or circuit breaker rated at 5 amps DC shall be
included in the building installation.

« Install the circuit breaker in close proximity to the
equipment and within easy reach of the operator.

* Mark the circuit breaker as the disconnecting device for
the equipment.

463X Chlorine Systems Manual
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Wiring Output

Follow all local and government recommendations and
methods for installation of electrical connections to and
between the system and other devices.

Output Connections

» Use the wiring enclosure terminal block for output wire
connections. Do not wire directly to the transmitter.

» Recommended torque for the terminals is 7 Ib-in.

* Do not run 4 to 20 mA loop cables in the same conduit as
the power or other high voltage wiring.

* Remove one installed jumper wire (from both of its terminals)
on the terminal block in the enclosure for each loop device
connected. Replace the jumper if you later remove your
loop device. If only one loop device is connected, remove
just one jumper wire from its two terminals.

» The panel system uses an active loop output wired to the
enclosure terminal block.

¢ If connecting to a PLC, use the PLC's passive input.

¢ The transmitter must have a jumper wire or loop
device always connected to Loop 1.

Wiring Label Legend

Earth Ground. Attach 4 to 20 mA loop cable
shield wire here to help eliminate possible noise.

Loop 1 |4 to 20 mA Loop #1

Loop 2 | 4 to 20 mA Loop #2

Relay 1 | Relay Output #1

Relay Normally Closed (contact) when

Ground

NC de-energized
C Common
NO Relay Normally Open (no contact) when

de-energized
Relay 2 | Relay Output #2 (terminals same as Relay #1)

WARNING

This panel system is

wired for AC voltages

that can injure or Kkill.
Wiring should be performed by
qualified personnel only.
Disconnect AC power before opening wiring enclosure.

PLC Terminals

Red

+| Channel 1
Black .| 4to20mA

Red
Black +| Channel 2
ac 41020 mA

PLC dual channel connection

Wiring a 4 to 20 mA loop device

Jumper wire removed

+GF+

463X Chlorine Systems Manual




Electrical Box Wiring Schematic

— — — — — — — — — — [— — _»
3-8630-3P (159 001 673) 1 Customer Wiring
| .
Transmitter | TerernaI
| Terminals Block
| Relay 2 (N.0.) | |!'.'1 2 | — 10 Il 10 | wo
Relay 2 (COM) | | @ 11 : z:act 9 || 9 | comreLav2
| Relay 2 (N.C) | |@ 10 Black 8 8 | nc
Relay 1(N.0) | |@ 9 : = 7 Il 7 1~
| Relay 1 (COM) |'. 8 : ::Z'; 6 1] 6 | comreLavs
| Relay 1(N.C) | |@ 7 * | e S | S _| NC
J \ White 4 4 -Loop2
i 3 1l 3 +LOOP 2
| Black 1T
| Yellow 7 | 7 —LOOP1
I +LOOP 1
| T
| GND : GND| EARTH GROUND
Loop 2 - l. 6
| Loop 2 + l. 5 | |
| System Power Loop 1 - 1 |. 4 |
System Power Loop 1 + ]. 3 | GND
| AUX Power - [. 2 ek -v| | N
| AUX Power + 1 [. 1 4 : Red +V |
L
]
| | Power, Supply
| 24 VDC
| — — _ _
| White -
I | X |
Ground . 18 —
| Digital (s°L) | |{@ 17 % | \'&
16 Black
| v+ @
® 15 “hie N . .
Digi::c(’::: I||:14 ht _ Signet pH Sensor Electronics
| ve 1@ 13— r 3-2750-7 (159 001 671)

Black

- —_ —_ —_- —_- —_- —_ —

Signet Chlorine Sensor Electronics
l 3-2650-7 (159 001 670)
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Chlorine Sensor Preparation

2630 Free Chlorine Electrode
2632 Chlorine Dioxide Electrode

» Chlorine sensors are shipped without internal electrolyte solution.

+ Prior to installation and supplying power, Chlorine sensors must be filled with the
appropriate internal electrolyte solution.

+ Verify the correct electrolyte solution is utilized with the corresponding sensor.

» Free Chlorine and Chlorine Dioxide sensor require different electrolyte solutions.

Avoid skin or eye contact with electrolyte solution.
A Wear rubber gloves and goggles.

Initial Fill Procedure:
When adding electrolyte, be prepared for an accidental spill.
Working near a sink is recommended.

1. Remove the protective bottle from the end of the electrode.

2. Remove the membrane cap from the front of the sensor.

Note: When new sensors are shipped, the membrane cap is not tightened to
the sensor.

3. Fill supplied syringe with electrolyte solution.

Additional caution should be taken when handling Chlorine Dioxide electrolyte solution.

4. Place the electrode on a level surface.

5. Insert syringe needle fully into one of the eight electrode holes while injecting with
electrolyte solution. Slowly injecting the electrolyte solution into the sensor to avoid
introducing air bubbles. The electrode holds approximately 14 milliliters of solution.
Slowly fill until solution begins to flow out of holes. Do not allow the solution to run
down the electrode and wet the electrical contacts in the DryLoc connector.

6. Slowly screw on the membrane cap finger tight. Do not use tools. To avoid damage
and contamination, do not touch the white membrane surface on the membrane cap.

Chlorine Sensor Calibration

A new chlorine electrode or one that has had the membrane cap changed must be
calibrated. See page 24, 8630 Transmitter information on calibration of the chlorine
sensor. A diethyl-p-phenylenediamine (DPD) colorimeter test kit (not included) is required
for sensor calibration. A sample is taken and analyzed with the DPD test kit, then this
value is entered into the Signet 8630 transmitter.

» Calibrate after a membrane cap change (requires 2 hour stabilization time).

» Calibrate after the internal electrolyte is replaced (requires 2 hour stabilization time).
» Check calibration one day after sensor is placed in service.

» Check calibration weekly to monthly depending on process requirements.

Chlorine Sensor Maintenance

The sensor membrane and internal electrolyte solution must be replaced over the life

of the electrode. To maintain accurate chlorine measurements, GF Signet recommends
that the internal electrolyte be replaced every 3 to 6 months, or when Chlorine readings
drift low and/or cannot maintain a calibration longer than 5 days. Actual interval between
maintenance of the sensor will be dependent on the actual applications, chlorine level and
contaminates in the water. See Appendix page 36; Maintenance and Storage.

Keep spare membrane caps available. Membrane caps carry no warranty.

To maintain accurate chlorine measurements, GF Signet recommends the internal
electrolyte be replaced and the gold sensor electrode be properly polished every
3 to 6 months. See Appendix, page 37.

* Material Safety Data Sheets (MSDS) are available online at www.gfsignet.com.

B~

J

W LT

'F

CAUTION:
DO NOT touch the gold tip or
the membrane of the sensor.

NOTE: Inspect and change the
membrane cap if damaged.
See page 36, Maintenance, for
cleaning procedure.

+GF+
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Sensor Installation

» Remove sensor access plugs from the flow cell (pg. 4, Figure 1).
Note: Chlorine Sensor Preparation must be completed prior to installation, see page 11.

» Holding the 3-2750-7 (159 001 671) or 3-2650-7 (159 001 670) electronics inverted, open the DryLoc® connector by
turning the upper locking ring “a-turn counter-clockwise.

* Insert the electrode facing up. Turn the locking ring Y-turn clockwise to lock the electronics in place.

* The mechanism will “click” when it is locked.

« Install the complete assembly into the flow cell and ensure the key on the electrode aligns with the key slot on the flow cell.

Wear rubber gloves and goggles. R
. . » Do Not Overtighten. Do Not Use Tools.
Material Safety Data Sheets (MSDS) are available Do Not Drop or Strike the Membrane.

online at www.gfsignet.com.

Avoid skin or eye contact with electrolyte solution. % Do Not Use Lubricant or Sealing Tape on Threads.
7
¥

DryLoc® Connection to Sensor Electronics

3-2724-00 Lubricate O-rings with 3-2630-X
(159 001 545) a non-petroleum FCL electrode
pH electrode based, viscous 3-2632
lubricant (grease) CIO. electrode
compatible with the 2
system. st

- : m

LY - |
1

Locking Ring Locking Ring

Lock
3-2650-7

(159 001 670)
Amperometric Electronics

3-2750-7
(159 001 671)
pH electronics

e
~“ ul | | "‘ “
n ] R
- S Signet 3-2630-X =
= l Signet 3-2632 =
- Chlorine Electrode
- v Signet 3-2724-00
w@ N (159 001 545)
l.! _ . Flat pH Electrode
. Signet 3-2650-7 F <
@ Electronics 0
Signet 3-2750-7
pH Electronics v

R /
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Tubing Connections

Use suitable 9.5 mm (3/8 in) ID tubing that is rated for your Valve position for start up and normal use.
inlet pressure. Use hose clamps. Note: Turn off inlet valve first when stopping water flow.

» The drain tube must be positioned lower than the influent
water source to allow proper flow through the flow cell.
The flow cell must drain by gravity, not system pressure.

Inlet Quick Release Connection

Press down gray plunger to release. Water flow is
automatically shut off when disconnected. * When testing, allow the sample to flow for a few seconds
before collection.

Drain Sampling port

Inlet (to outlet) (flow off)
Flow Rate
The flow rate is in the proper range when the float is For Low Flow applications (flow less than 1 bar/15 psi), the
between the Min. and Max. markers on the flow cell. The Flow Regulator can be removed and the flow adjusted using
flow range limits are 30.24 to 45.36 L/h (8 to 12 gal/h). the Flow Cell ball valve. (NOTE: The inlet hose barb will also

need to be changed. Contact factory for details.)

2

pH cl

ouT
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8630 Chlorine Transmitter

The Signet 8630 ProcessPro® Chlorine Transmitter displays and transmits free chlorine or chlorine
dioxide, along with pH information when connected to Signet Amperometric Chlorine Sensors and

a Signet pH Sensor. +GF+

Features of the 8630 include: w

» Displays Free Chlorine measurements from 0 to 20 ppm (parts per million) or Chlorine Dioxide -
measurements from 0 to 2 ppm. iyt Transmitter sz

» Specifies all compatible chlorine sensors.

» Automatic pH and temperature compensation or manual pH input to calculate accurate Al v| p| am

free chlorine measurements.
» Simple setup and easy customization with the 4-button keypad.
* Dual 4 to 20 mA outputs with two built-in SPDT mechanical relays.
» Easy viewing via the bright backlit LCD display.

CAUTION!
A * Remove power to unit before wiring input or output connections.
» Follow instructions carefully to avoid personal injury or damage to the transmitter.

8630 View Mode

* The View Menu is displayed during normal operation.

» To select a VIEW display, press the A or V¥ keys. The selections will scroll in a continuous loop. There are four pages to view.

» Changing the VIEW display does not interrupt system operations.

» No key code is necessary to change display selection.

» Output settings cannot be edited from the VIEW menu.

» All menus time-out after 10 minutes and return to the previous operating display.

* When editing the CALIBRATE or OPTIONS menus, the transmitter will return to the default display after 10 minutes and then
the VIEW menu in another 10 minutes if no activity occurs.

- ~<

l,,’ \\
,’l FCl: 2.67 ppm View chlorine, pH and temperature values from the sensor.
'/ 7.10 pH 25.3 °C FCI = free chlorine, CIO2 = chlorine dioxide.
,,' The example View menus below return to the default display after 10 minutes.
1

Cl Raw: 103.8 nA | Chlorine (nA)and pH raw (mV) signals from the sensors.
pH Raw: -5.9 mV For reference only.

Loop 1 10.68 mA
Loop 2 8.56 mA

\ 1

X Last CAL:
\ 10-18-10

View of current loop 1 and loop 2 output.

View of the last calibration date. Editable in the Calibrate Menu.

———————
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8630 Editing Procedure

The 8630-3 (159 001 662) has two menus the user can edit: CALIBRATE and OPTIONS.
+ The CALIBRATE menu allows you to calibrate and initialize sensors, define current loops and set relay functions.
+ The OPTIONS menu allows you to set sensor type, adjust and test current loops, test relays and more.

4 )
Press and hold the ENTER key:

» 2 seconds to select the CALIBRATE menu.

» 5 seconds to select the OPTIONS menu.

Enter the Key Code.
The Key Code is A-A-A-V keys in sequence.
 After entering the Key Code, the display will show the first item in the selected menu.

Scroll the menu in a loop with the ¥ or A arrow keys.

Press the > key to select the menu item to be edited.
» The first display element will begin flashing.

Press the A or V keys to edit the flashing element.
* The » key advances the flashing element.

Press the ENTER key to save the new setting and return to Step 3.

Made an Error? n Finished Editing?

Press the A and V¥ keys simultaneously Press the A and ¥ keys simultaneously
while any element is flashing. This will recall after saving the last setting to return to
the last saved value of the item being edited N View menu =

and will return you to Step 3.

+GF+ 463X Chlorine Systems Manual 15



8630 Editing Procedure

Example: Calibration

ENTER

ENTER

Access the CALIBRATE Menu:
Press and hold the ENTER key for 2 seconds to access
the CALIBRATE menu.

Enter the Key Code:

The CALIBRATE and OPTIONS menus require a
password (KEY CODE). Pressingthe A, A, A, V keys
in sequence unlocks the display and the first menu item
will appear. If no key is pressed for 5 minutes while the
display is showing "Enter Key Code", it will return to the
VIEW menu.

Scroll the Menu:

Press the ¥ or A keys to scroll through the Menu.
While in this mode, pressing the A and V keys
simultaneously will return the display to the VIEW menu.
If no key is pressed for 10 minutes, the display will
return to the VIEW menu.

Select the item to be edited:

In this example, "Last Cal" (last calibration date) is
chosen to edit. Pressing the » key selects the menu
item and enters the screen into edit mode.

Edit the flashing element:

This is the edit mode.

The A or V¥ keys change the flashing element.

The » key advances the flashing element in a
continuous loop. In this example, the "Last Cal" date
was changed from 09-18-09 to 10-18-09.

All output functions remain active during editing.
Only the flashing element can be edited.

Press ENTER to save the new value.

When you have set your desired value, pressing the
ENTER key stores the value on the screen, making it
immediately available to output functions and exits you
back to Step 3.

\
CALIBRATE menu

CALIBRATE:
Enter Key Code

CALIBRATE:
Enter Key Code

CALIBRATE: --
Enter Key Code

CALIBRATE: -
Enter Key Code

Cl Zero
Calibration: >

2\

Cl Zero
Calibration: >

1 Y

Last Cal:
09-18-09 >

\\_/Example

Last Cal:
09-18-09 >

Last Cal:
09-18-09

Last Cal:
19-18-09

Last Cal:
19-18-09

Last Cal:
10-18-09

Last Cal:
Saving

Last Cal:
10-18-09

> OPTIONS

menu

-y

A

v
-

ENTER|

U
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8630 Calibrate Menu

The menus below are displayed here in the order seen when scrolling down through the Calibrate Menu.

NOTE:
For greater accuracy it is recommended that the initial calibration of the system should be in the following order:
1. Temperature
2. pH electrode (if optional pH sensor is installed. If manual pH sensor is selected enter the pH value into the option menu prior
to calibrating the chlorine sensor)
3. Chlorine sensor.
. . . . (Hold) @
* Although the Calibrate Menu can be navigated upwards or downwards, it is best to navigate downwards when ,
editing Current Loop and Relay settings as previous entries can influence subsequent menus.
+ Chlorine and pH calibration screens will be shown only when a valid sensor is detected.

u n Press the A or ¥ Arrow u Press the b key to enter Edit mode. Press the Enter key to save
key to scroll through the menus. your settings.

Calibrate Menus

Factory settings shown Description

Chlorine Units: This is the first screen. Choose units of measurement: ppm or mg/l.

ppm >
Cl Zero When > is pressed, the “live” readings are shown. The nA value is displayed, but cannot be
Calibration: > edited and is used for diagnostic and calibration purposes. When in Edit Mode, pressing Enter

stores the displayed value as your zero reference.

Cl In Process

Calibration: > Enter process chlorine value determined from a DPD test kit here.

Reset Cl to This menu resets Cl readings, Zero Calibration and temperature back to Factory Calibration.
Factory Cal: > | WARNING! User entered Cl calibration settings will be lost.

Cl Temperature Enter process temperature from a reference thermometer: °C or °F. Units are set up in the
Calibration: > | Options Menu.

NOTE: The next two pH calibration screens will be shown only when a valid pH sensor is detected.

pH Standard

Calibration: > Set pH standard value. This applies a linear offset to the pH measurement.

pH Slope Applies a slope to the pH measurement. The slope and standard value must be at least
Calibration: > | 2 pH units apart.

Reset pH to Reset pH standard, slope or back to Factory Calibration.
Factory Cal: > | WARNING! User entered pH calibration settings will be lost.

Current Output Functions

Loop 1 Source:

Chlorine > Choose chlorine or pH for this 4 to 20 mA current loop.

Loop 1 Rng: ppm Select the minimum and maximum values for the current loop output. Units are derived from
0.00 > 5.0 > Loop 1 Source. If the Source 1 is changed, be sure to re-edit this page.

Loop 2 Source:

pH Choose pH or chlorine for this 4 to 20 mA current loop.

Loop 2 Rng: pH Select the minimum and maximum values for the current loop output. Units are derived from
00.0 ->14.00 > | Loop 2 Source. If Source 2 is changed, be sure to re-edit this page.

+GF+ 463X Chlorine Systems Manual 17



8630 Calibrate Menu

Relay Functions

Verify all relay settings if the Relay Source is changed.

Relay 1 Mode:

off >

Choose mode of operation: Off, Low, High, Window, or Pulse. If Off, all subsequent Relay 1
functions are inactive and not visible.

If Low or High Mode was chosen:

Relay 1 Source:
Chlorine >

Choose chlorine or pH for Relay 1.

Relay 1 Setpnt:
©.00 ppm >

In Low or Hi Mode, Relay 1 will be activated when the process reaches this value.
Units of measure reflect Relay 1 Source.

Relay 1 Hys:
0.20 ppm >

Relay 1 will be deactivated at Relay 1 Setpoint + this hysteresis setting depending on High or
Low Setpoint selection.

Relay 1 Delay:
0.0 secs >

Set the time delay for Relay 1 to activate after reaching the Setpoint.
Range: 0 to 6400 seconds.

If Window Mode was chosen:

Relay 1 Source:
Chlorine >

Choose chlorine or pH for Relay 1.

Relayl Rng: ppm
0.00 > 5.00 >

Enter the range where Relay 1 will activate above and below this setpoint.

Relay 1 Hys:
0.20 ppm

v

Relay 1 will be deactivated at Range setpoints + this hysteresis setting.

Relay 1 Delay:
0.0 secs >

Set time delay for Relay 1 to activate after reaching the setpoints set in Relay 1 Range.

If Pulse Mode was chosen:

Relay 1 Source:
Chlorine >

Choose chlorine or pH for Relay 1.

Relayl Rng: ppm
0.00 > 5.00 >

Enter the range where Relay 1 will activate above and below this setpoint.

Relayl PlsRate:
120 pulses/min >

Set the maximum pulse rate. Range: 1 to 400 pulses/min.

Relay 2 Mode:

Choose Relay 2 mode of operation: Off, Low, High, Window, or Pulse.

off > | To disable this relay choose Off.

If Low or High Mode was chosen:

Relay 2 Source:
pH

Choose pH or chlorine for Relay 2. This menu screen and all subsequent Relay 2 screens
below do not appear if Relay 2 Mode is set to Off.

Relay 2 Setpnt:
0.00 pH >

In Low or High Mode, Relay 2 will be activated when the process reaches this value.
Units of measure reflect Relay 2 Source.

Relay 2 Hys:
0.20 pH

v

Relay 2 will be deactivated at Relay 2 Setpoint + this hysteresis setting depending on High or
Low Setpoint selection.

Relay 2 Delay:
0.0 secs >

Set the time delay for Relay 2 to activate after reaching the Setpoint.
Range: 0 to 6400 seconds.

18
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8630 Calibrate Menu

If Window Mode was chosen:

Relay 2 Source:
pH

Relay 2 Rng: ppm
0.00 > 5.00 >

Relay 2 Hys:
0.20 ppm >

Relay 2 Delay:
0.0 secs >

If Pulse Mode was chosen:

Choose pH or chlorine for Relay 2.

Enter the range where Relay 2 will activate above and below this setpoint.

This relay will be deactivated at Relay 2 Range setpoints + this hysteresis.

Set the time delay for Relay 2 to activate after reaching the setpoints set in the
Relay 2 Range.

pH

Relay 2 Source:

> Choose pH or chlorine for Relay 2.

Relay2 Rng: pH
0.00 > 14.0

> Enter the range where Relay 2 will activate above and below this setpoint.

120 pulses/min

Relay2 PlsRate:

> Set the maximum pulse rate. Range: 1-400 pulses/min.

Find New
Sensor(s): >

Last Cal
10-18-09 >

Required only when a new sensor is changed while the power is on. Choose Yes or No.

Edit the calibration date.

End of Calibrate Menu

+GF+
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8630 Options Menu

The menus below are displayed here in the order seen
when scrolling down through the Calibrate Menu.

3 % OPTIONS menu

u n Press the A or ¥ Arrow key to u Press the b key to enter Edit mode. Press the Enter key to save
scroll through the menus.

your settings.

Options Display
(Factory settings shown)

Description

Contrast:
3 >
Cl Sensor Type:
Free Cl >
pH Input

Sensor >

Adjust the LCD contrast for best viewing. A setting of 1 is lower contrast, 5 is higher.

Select the chlorine sensor: Free Cl or CIO2.

Choose Manual or Sensor. If Sensor is chosen, the pH value from the connected pH sensor will be
used. Choose Manual to enter a pH value manually when no sensor is connected or if measuring
chlorine dioxide.

If Manual pH input was chosen:

Manual pH Value
7.000 pH

Enter your pH value here if a pH sensor is not connected.

Temp Display:
°C

Averaging:
off >
Decimal:
***.** >

Loop 1 Adjust:
4.00 mA >

Loop 1 Adjust:
20.00 mA >

Loop2 Adjust:
4.00 mA >

Loop2 Adjust:
20.00 mA >

Test Loop 1:

Test Loop 2:

Choose units of °C or °F.

OFF gives the fastest response to input changes. LOW = 4.5 seconds, HIGH = 9 seconds of averaged
response. Increase averaging to steady the display.

Select the decimal point for the display. Maximum of 2 decimal places.

Adjust the minimum current output for Loop 1. The display value represents the precise
current output. Range: 3.80 mA to 5.00 mA.

Adjust maximum current output for Loop 1. Range: 19.00 mA to 21.00 mA.

Adjust the minimum current output for Loop 2. Range: 3.80 mA to 5.00 mA.

Adjust maximum current output for Loop 2. Range: 19.00 mA to 21.00 mA.

Press UP or DOWN keys to manually output any current value from 3.6 mA to 21.00 mA to test
Loop 1 output.

Press UP or DOWN keys to manually output any current value from 3.6 mA to 21.00 mA to test
Loop 2 output.

20 463X Chlorine Syste
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8630 Options Menu

Test Relay 1:

>
Test Relay 2:
Read Sens Data:
No >

If Yes was chosen:

Cl Sensor S/N:
XXXXXXXXX

Cl Type & Range:
2630 XXxXX.X ppm

Zero Cal: ppm&nA
XXX o XX XXXX.X

In Proc: ppm&nA
XXX+ XX XXXX.X

Temp at Cal:
XXXX.X °C

pH at Cal:
XXX . XX pH

Temp Offset:
XXXX.X °C

Elapsed Time:
XXXXX. hrs

Low & High: °C
SXXXX. X HXXXX. X

Press UP or DOWN keys to manually toggle Relay 1 Off and On. The left LED on the front of
the transmitter confirms operation.

Press UP or DOWN keys to manually toggle Relay 2 Off and On. The right LED on the front of the
transmitter confirms operation.

If "YES" is selected the following (Read Only) screens will be shown.
If "NO" then this menu ends the Options Menu.

View the sensor serial number.

Identify the chlorine sensor type connected and its ppm range.

View user entered Zero Calibration data in ppm and nA.

View user In-Process Calibration value when it was entered in the Calibrate Menu.

Temperature recorded during user In-Process Calibration.

pH value recorded during user In-Process Calibration.

Temperature offset calculated from user entered temperature calibration from Calibrate Menu.

Total hours of operation.

Lowest and highest temperatures the Cl sensor has been subjected to during operation.

End of Options Menu

+GF+
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Chlorine Sensor Conditioning

A new chlorine sensor or one that has had the electrolyte

or membrane replaced must be conditioned to generate
stable and accurate readings. To condition a chlorine sensor,
the sensor and sensor electronics must be installed and
powered, and must also have chlorinated water flow across
the membrane.

Chlorine Sensor Conditioning

1. Turn on and adjust water flow rate. Condition a new
chlorine sensor for 4 hours. Conditioning time for a
membrane cap replacement and/or electrolyte refill is
2 hours.

2. Keep offline any 4 to 20 mA devices or relay actuated
output devices that connect to the transmitter.

NOTE: The membrane cap may have to be replaced when
electrolyte is changed. Replace membrane if damaged.
The electrolyte should be replaced every 3 to 6 months.

pH Sensor Calibration

If a pH sensor is part of the system, use the Calibration
Kit 3-2700.395 (159 001 605) prior to initially installing
the sensor and during its normal lifetime. If a pH sensor is
not available but pH determination is necessary, measure
process pH with a separate test and enter the value in the
Options Menu.

NOTE: Temperature must be calibrated before calibrating the
pH sensor. See Chlorine Sensor section.

Refer to your pH sensor manual.

The pH sensor needs to be calibrated against two different pH
buffer references to calibrate the offset (standard) and slope.
Electrode offset is any deviation from 0 mV in a pH 7 buffer at
25 °C. Slope is the ratio of mV to pH units.

» Always keep any output devices offline when calibrating.

Set pH Offset (Standard)

The transmitter must be powered on and the pH sensor must

be connected.

1. Turn off the water flow through the system, then remove
the pH sensor from its flow cell.

2. Using pH buffer 7.0, place enough pH buffers into
clean calibration cups, supplied with the pH calibration
kit 3-2700.395 (159 001 605), to cover the tip of the
electrode.

3. Pour distilled water in another clean cup for rinsing the
electrode between buffers.

4. Rinse probe, place the pH sensor in the pH 7.0 buffer
and allow the mV reading to stabilize.

Example: Set pH Standard to 7.00.

[ Go to the Calibrate Menu.
Scroll down ¥ 5 menus to the pH Standard menu.
Press » to enter Edit Mode.
Enter the pH value of the buffer that the electrode is
placed in; 7.00 in this case.
Press the Enter button to save the setting.

0. | Exit to the View Menu.@

5
6.
7.
8

= ©

View Menu

FCl: 2.67 ppm

Step 4
7.11 pH 25.3°C

(Hold)

6 pH Standard
Calibration:

7 [
pH Standard Cal:
07.00 pH/ @ mV

a4
pH buffer value

entered here

Calibrate Menu
>

NOTE: The pH sensor will not calibrate when the mV value
exceeds 50 mV from the original new electrode specification.
Electrode: pH 4.01 =+ 177 mV.

22
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pH Sensor Calibration

1.

2.

4.
5.
6
7.
8.

9.
10.

Set pH Slope

Remove the pH sensor from the first buffer solution and
rinse it in distilled water.

Place the pH sensor in a different buffer solution
(example: pH 4.01). The pH standard and slope must be
at least 2 pH units apart.

Note the pH and mV readings on the View Menu and
allow it to stabilize.

Example: Set pH slope to 4.01.

s )

Scroll down ¥ 1 menu to the pH Slope menu.
Press » to enter Edit Mode.

Enter the pH value of the buffer that the electrode is
placed in; 4.01 in this case.

Press the Enter button to save the settings.

pH buffer value
entered here

Exit to the View Menu. (A Y)

Replace the pH sensor back into its flow cell.
Turn on the water flow.
The pH sensor calibration is complete.

pH Standard Cal:
07.00 pH/ © mVv

View Menu

4 pH Slope
Calibration:

5 =
pH Slope Cal:
04.01 pH/ +177 mV

ENTER|

0

Calibrate Menu
>

Set Manual pH Compensation

If the pH of the application is stable, then the pH of the
application can be entered manually and will be used to
calculate the free chlorine measurements.

NOTE: Chlorine dioxide does not require pH compensation.

Example: Change the pH input from Sensor to Manual
and enter a pH value of 7.22.

1.] Go to the Options Menu.
2.| Scroll down ¥ 2 menus to the pH Input menu.
3.| Press » to enter Edit Mode.
4.| Choose Manual and press Enter.
5.1 Scroll down ¥ 1 menu to the Manual pH Value menu.
6.| Press » to enter Edit Mode.
7.| Enter your new process pH value: 7.22.
8.| Press the Enter button to save the setting.
9. | Exit to the View Menu. av)
Step 2 pH Ing:ﬁsor > Options Menu
4 pH Input
Sensor Manual
S Manual chosen
5 pH Input
Manual >
7 Manual pH Value
7.220_pH

ENTER

New pH value entered

+GF+
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Chlorine Sensor Calibration

Chlorine sensors need to be calibrated for accuracy.
Calibration must be done with every new sensor and

any time a membrane cap is replaced. After the 4 hour
conditioning period, Temperature Calibration and
In-Process Calibration needs to be performed. Any 4 to 20
mA or relay output devices should be offline.

Chlorine Sensor Temperature Calibration

The temperature element inside the chlorine sensor needs
to be calibrated. Use a reference thermometer to verify

the actual temperature of the sample. This value is then
entered in Step 4 to calibrate the system. After completing
Temperature Calibration, proceed to In-Process Calibration,
page 25.

Tip: Remove the pH electrode from the flow cell and insert
the reference thermometer. If no pH sensor is being used,
remove the cell plug to insert the thermometer. Replace the
plug after calibration.

Example: Set the calibrated temperature to 25.3 °C.

Go to the Calibrate Menu.

Scroll down ¥ 3 menus to the Cl Temperature menu.
Press » to enter Edit Mode.

Enter the temperature reading. Example: 25.3.

Press the Enter button to save the setting.

Exit to the View Menu. (A ¥)

ok wh =

Cl Temperature .
Step 2 IR TN Calibrate Menu
4 | C1 Temp: Cal
+025.3 °C

ENTER

New temp. value

Zero Point Calibration

Zero Point Calibration is only used at the factory to program
the sensors zero calibration point. This value does not shift
throughout the life of the electrode and does not need to

be performed in the field. After completing Temperature
Calibration, proceed to In-Process Calibration, page 25.

For Reference Only:

The chlorine sensor needs to be calibrated against two
chlorine references: zero chlorine and the process chlorine.
Typically the zero point calibration is very stable. Calibration
must be done with every new sensor and any time a
membrane cap is replaced.

1. Keep offline any 4 to 20 mA devices or relay actuated
output devices that connect to the transmitter.

2. Turn off the water flow and remove the powered chlorine
sensor with the electronics still attached.

3. Place the sensor tip in distilled water.

4. Wait until the reading stabilizes, then save the
calibration. Stirring the sensor in water is not necessary,
but allows the signal to stabilize faster.

Example: Set the Zero Point Calibration at 1.0 nA.
Go to the Calibrate Menu.
Scroll down ¥ one menu to the Cl Zero menu.
7. | Press » to enter Edit Mode. The live sensor readings in
ppm and nA will be flashing. These readings cannot be
modified, but can only be saved as displayed.
8. | Press the Enter button at the lowest reading to save the
setting or press (A ¥) to escape without changes.
9. | Exit to the View Menu. (A V)

\ J

oo

10. After Zero Point Calibration is complete, replace the
sensor back into the flow cell and turn the water flow
back on.

11. Wait until the chlorine readings stabilize once again, then
perform a chlorine In-Process Calibration.

Cl Zero:
Calibration >

8 Zero Cal: ppm&nA
0.20 / 001.0

Step 6 Calibrate Menu

Lowest value noted for
Zero Cal.
The signal level during a Zero Point

Calibration must be at least 1 nA lower
than the In-Process Calibration point.
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Chlorine Sensor Calibration

In-Process Calibration

A diethyl-p-phenylenediamine (DPD) colorimeter test kit (not
included) is required for sensor calibration. A sample is taken
and analyzed with the DPD test kit, then this value is entered
into the Signet 8630 transmitter.

1. Take a water sample from the Sampling Port (after
purging it) from a stabilized and running system.

2. Use this sample to measure the chlorine content with
a colorimetric DPD test kit (not included). Refer to the
DPD kit instructions on how to perform this test.

NOTE: For greater accuracy, it is recommended
that the DPD test be repeated three times and
the results averaged.

3. Record the test results.

Example: Set the Chlorine In-Process to 2.67 ppm.

4. | Go to the Calibrate Menu.

5. | Scroll down ¥ 2 menus to the Cl In-Process menu.

6. | Press » to enter Edit Mode.

7. | Enter the chlorine reading determined from the DPD test
into the edit screen: 2.67 ppm. The Cl ppm is editable
and must be at least 0.2 ppm.

8. | Press the Enter button to save the setting.

9. | Exit to the View Menu. (A Y)

Calibration is complete for the chlorine sensor.

Cl In Process

Step 5 | S e S Calibrate Menu
7 In Proc: ppm&nA
2.67 / 1e3.8

/ ENTER

DPD CI ppm value
entered here.

The signal level during an In-Process
Calibration must be at least 1 nA higher
than the previous Zero Calibration point.

Output Settings - Loops and Relays

Configure the current loop and relay functions if applicable.
NOTE: The current and relay outputs can be tested in the
Options Menu.

Current Loop Settings
Current outputs are passive outputs that can be spanned in
the forward and reverse direction. Example: 0 to 5 or 5 to 0.

Example: Set a current loop source as chlorine and the
operational range to 0 to 5 ppm.

Go to the Calibrate Menu.

Scroll down V¥ to the Loop 1 Source menu.

Press » to enter Edit Mode.

Choose either the chlorine or pH sensor as the source
that will control this loop: Chlorine.

Press the Enter button to save the setting.

pPoONM=

o

Scroll down ¥ 1 menu to the Loop 1 Rng menu.
Press » to enter Edit Mode.

Select the minimum and maximum process values for
the current loop output: 0 to 5 ppm.

9. |Press the Enter button to save the setting.

© N

10. | Exit to the View Menu.

NOTE:

When integrated into the 463X Chlorine Panel Assembly,
the loop outputs are wired into Active outputs via the
terminal strip found inside the 463X enclosure.

Loop 1 Source: i
Step 2 Calibrate M
°p Chlorine > | e e
Set and save
6 Loop 1 Rng: ppm
0.00 > 5.00 >

Set and save

+GF+
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Output Settings - Loops and Relays

Mechanical Relay Functions

The 8630 relays are selectable and configurable and can

be used as switches that respond when the process value
moves above or below a user defined setpoint. They can

be used for Low Alarm, High Alarm or Proportional Pulse
triggering related to the process value. Relay functions,
hysteresis and time delay settings are set up in the
CALIBRATE menu and can be tested in the OPTIONS menu.

& Low Setpoint:
Relay is energized when the measured value is less than
the setpoint.

< High Setpoint:
Relay is activated when the measured value is higher than
the setpoint.

€ Window:

Relay is off within the window of two setpoints minus the
hysteresis. Relay is activated when the value is higher or
lower than the high and low setpoint.

JU1 Pulse-frequency Operation:

The transmitter can output a pulse at the rate defined by
the settings in the CALIBRATE menu and the sensor input.
The maximum pulse square wave output from the relays is
400 pulses per minute. Example usage would be to control
solenoid operated dosing pumps.

Example: As the process value drops below the setpoint

(4 mg/l) the output will start pulsing in relation to the process
value, the maximum pulse endpoint and the programmed
pulses/minute. The pulse rate will increase as the process
value decreases and approaches the programmed endpoint.
This functionality can be used to precisely control the
process.

» The output will be 0 pulses/minute when the input value is
greater than 4 mgl/l.

» The output will be 35 pulses/minute when the input value is
3 mgl/l.

* The output will be 100 pulses/minute when the input value
is 1 or less.

The starting point, endpoint and maximum pulse rate are
selectable in the CALIBRATE menu.

Process

Hysteresis

Low Setpoint |~

Time
< Relay energized
Relay de-energized ¢
Process
High Setpoint | -
Hysteresis
Time
Process
High Limit 2~~~ TTTTNe U UUUTTTTTTTTY Hysteresis
Low Limit Y- oo _____1- Hysteresis
Time
100
T 80
=}
=
€
% 60
[oN
%]
[0}
(2]
S 40
=
=
Q.
5 20
(@)
0 1 1 1
1 Input (mg/l) 4mgl/l  <€--
Ending Starting
Point Point
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Output Settings - Loops and Relays

Relay Settings

Example: Set a relay to energize at a low setpoint of
1.0 ppm with a time delay of 15 seconds and de-energize
at 1.30 ppm.

¢ Once a setting is saved it immediately becomes
active.

Go to the Calibrate Menu.

Scroll down ¥ to the Relay 1 Mode menu.
Press » to enter Edit Mode.

Scroll down ¥ and choose Low.

Press Enter.

abrwd=

o

Scroll down V¥ to the Relay 1 Source menu. The default
is Free Chlorine.

7. | Scroll down V¥ to the Relay 1 Setpnt menu.

8. | Press » to enter Edit Mode.

9. | Set the ppm value to trigger the relay: 1.00 ppm.
10.| Press Enter.

11.| Scroll down V¥ to the Relay 1 Hys menu.

12.| Press » to enter Edit Mode.

13.| Set the hysteresis (dead zone) for this relay. This affects
the turn off only: 0.3 ppm.

14.| Press Enter.

15.| Scroll down V¥ to the Relay 1 Delay menu.

16.| Press » to enter Edit Mode.

17.| Set the turn-on delay in seconds for the relay: 15 secs.
18.| Press Enter.

19.| Exit to View Mode. (A V)

» Relay function can be tested in the Options Menu.

Cl ppm

1.30 - {---

100 -4- _Sgtpoint

1 "
T > Time

Step 4

13

17

Time Delay

< Relay energized
Relay de-energized ¢

Relay 1 Mode:

Calibrate Menu
Low >

Set and save

Relay 1 Source:
Chlorine >

Set and save

Relay 1 Setpnt:
1.00 ppm >

Set and save

Relay 1 Hys:
0.30 ppm >

Set and save

Relay 1 Delay:
15.0 secs >

Set and save
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2650-7 Amperometric and 2750-7 pH DryLoc® Electronics

» The Signet 2650-7 Amperometric Electronics provide the polarization voltage and signal conditioning required by the Signet

2630-X and 2632-X Sensors.

» The Signet 2750-7 pH Electronics conditions and amplifies the output from the Signet 2724-00 pH Electrode.
» Both units output a Digital (S°L) signal to the Signet 8630 Chlorine Transmitter.

CAUTION!
A * Remove power before wiring.
» Follow instructions carefully to avoid personal injury or

damage to the electronics.

Wiring to the Signet 8630 Chlorine Transmitter

The electronics are pre-wired from the factory to the transmitter. Refer to the following

schematics when replacing the electronics.

—White_ ¢ signal Ground —>»[lo1s
~—Red ¢ Digital (5°L) data —[[|O[17
Black _ +5VDC —)EO 16

Shield
N/C

pH
Signet 3-2750-7
(159 001 671)

White < Signal Ground —)@ O
~—Red__ ¢ Digital (S°L) data —[[| O
Black < +5VDC ——» E O

15
14
13

Shield

N/C

Chlorine
Signet 3-2650-7
(159 001 670)

Gnd

o]

v+

Gnd

1o

v+

+GF+

Signet Chiorine

Transmitter puys

+GF+

Signet Chiorine
Transmitter  asy

» Refer to the wiring diagram above to connect the 2650 cable to the terminals on the 8630 Chlorine Transmitter.

 For calibration and configuration please refer to the 8630 Calibrate Menu discussions above.
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Chlorine Electrode Overview

CAUTION!
A 1 Follow instructions carefully to avoid personal injury or damage to electrode.
2. Prior to installation or removal:
a. Disconnect flow through system.
b. Drain below sensor level.
3. Confirm chemical compatibility before use.
4. Do not alter product construction.

The electrodes should not be used in water containing
surfactants, oils, organic chlorine or stabilizers such as
cyanuric acid.

These electrodes require the Signet 2650 Amperometric Electronics module to communicate with the Signet 8630-3P
Chlorine Transmitter.

Electrode Range: The electrodes must match the type and range of chlorine concentration to be measured.
Flow Rate: The electrodes must have a stable and constant flow of water past its membrane for accurate measurement.

When the sensor is installed in the Flow Cell Block 3-4630.392 (159 001 690), the flow rate range is controlled by the internal
flow regulator and the flow rate is reduced to 30.24 to 45.36 LPH (8 to 12 US gph).

Sensor Conditioning: A new chlorine electrode requires conditioning of up to 4 hours with the electrode powered on and
chlorinated water flowing across the membrane to generate a stable reading. Subsequent start-ups can require an electrode
conditioning of up to 2 hours.

The maximum allowable operating pressure must be

less than 1 bar (15 psi). Higher pressures will damage
the electrodes.

2630 Amperometric Chlorine Electrodes

The Signet 2630 Amperometric Chlorine Electrodes are designed to measure
free chlorine in ranges of 0 to 2 ppm, 0 to 5 ppm or 0 to 20 ppm.

Mfr. Part No. Code Chlorine Range Chlorine Type
3-2630-1 159 001 746 0 to 2 ppm (mg/L) Free chlorine
3-2630-2 159 001 662 0 to 5 ppm (mg/L) Free chlorine
3-2630-3 159 001 747 0 to 20 ppm (mg/L) Free chlorine

Mfr. Part No.
3-2632-1

Code

159 001 767

Chlorine Range
0 to 2 ppm (mg/L)

2632 Amperometric Chlorine Dioxide Electrodes

The Signet 2632 Amperometric Chlorine Dioxide Electrode is designed to measure
chlorine dioxide (CIO,) in a range of 0 to 2 ppm.

The Signet 2632 Amperometric Chlorine Dioxide Electrode has an integrated
temperature element for automatic temperature compensation.

Chlorine Type
‘ Chlorine Dioxide

Lubricate O-rings

with a non-petroleum
based, viscous lubricant
(grease) compatible with
the system.

Lubricate O-rings

with a non-petroleum
based, viscous lubricant
(grease) compatible with
the system.

+GF+
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2632 Amperometric Chlorine Dioxide Electrodes

pH Compensation for Free Chlorine

Amperometric free chlorine sensors measure only
hypochlorous acid. As noted in the text above and in Figure
1, the ratio of hypochlorous acid and hypochlorite is pH
dependent. In many applications the process pH is relatively
stable and no correction is needed. However, where the pH
of the water changes significantly, accurate free chlorine
measurement requires pH compensation. With the addition
of a pH sensor, the Signet 8630 transmitter will automatically
compensate the free chlorine reading for changes

in pH.

Automatic pH Compensation and Free Chlorine

In many applications, the process pH does not significantly
fluctuate and only a free chlorine sensor and instrument is
necessary for accurate chlorine measurement. It is when
the pH varies that free chlorine concentration can not
accurately be determined without the use of automatic pH
compensation.

The addition of the Signet 3-2724-00 (159 001 545) pH
electrode along with its 3-2750-7 (159 001 671) preamplifier
to the system makes pH compensation extremely easy and
automatic even with wide fluctuations or high pH.

See Figure 2 for pH variation recommendations.

Example:

If the pH nominal value is 7.5 and the pH variation is £ 0.2
then automatic pH compensation is recommended.

If the pH nominal value is 7.0 and the pH variation is £ 0.2
then automatic pH compensation is not required.

Calibration

A new chlorine electrode or one that has had the membrane
cap changed must be calibrated. See page 24, 8630
Transmitter information on calibration of the chlorine sensor.
A diethyl-p-phenylenediamine (DPD) colorimeter test kit (not
included) is required for sensor calibration. A sample is taken
and analyzed with the DPD test kit, then this value is entered
into the Signet 8630 transmitter.

» Calibrate after a membrane cap change
(requires 4 hour stabilization time).
» Calibrate after the internal electrolyte is replaced
(requires 2 hour stabilization time).
» Check calibration one day after sensor is placed in service.
» Check calibration weekly to monthly depending on
process requirements.

Maintenance

The sensor membrane and internal electrolyte solution
must be replaced over the life of the electrode. To maintain
accurate chlorine measurements, GF Signet recommends
that the internal electrolyte be replaced every 3 to 6 months,
or when Chlorine readings drift low and/or cannot maintain
a calibration longer than 5 days. Actual interval between
maintenance of the sensor will be dependent on the actual
applications, chlorine level and contaminates in the water.
See Appendix page 36; Maintenance and Storage.

Keep spare membrane caps available.
Membrane caps carry no warranty.

— 0
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Sample pH

— Automatic pH compensation recommended
in ranges within shaded area

NOTE: Inspect and change the membrane cap if damaged.
See page 36, Maintenance, for cleaning procedure.
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2724 DryLoc pH Electrode

CAUTION!
A 1. Use appropriate eye, face, hand, body and/or respiratory protection when using chemicals or solvents.
2. Prior to installation or removal:
a. Depressurize and vent system.
b. Drain below sensor level.
3. Confirm chemical compatibility before use.
4. Do not alter product construction.
Lubricate O-rings
with a non-petroleum
based, viscous lubricant
WARNING: 3-2724-00 (159 001 545) is the only recommended (grease) compatible with
electrode to be used in the Chlorine Analyzer System. the system.

Electrode Date Code

The electrode date code indicates the manufacturing date of the electrode. Electrodes should be put into service as
soon as possible and should not remain in the box for more than two years. Over time, the storage solution (found in
the "boot" covering the electrode tip) will evaporate or leak, allowing the delicate sensing tip and reference junction dry.

To rehydrate a dry electrode, soak it in pH 4 buffer for 24 to 48 hours. Electrodes more than 2 years old may still be
functional, but will take longer to rehydrate. Restoration may not be effective for severely dehydrated electrodes.

First Digit = Month Second Digit = Year

N = January 5=2010

M = February 6=2011

L = March 7=2012

K = April 8=2013

J = May 9=2014

H = June 0=2015

G = July 1=2016

F = August 2=2017

E = September 3=2018

D = October 4=2019

C = November

B = December Example: K5 = manufactured in April 2010
Removing the electrode from In-line installations \/

The use of this product assumes that operators are trained and are familiar with this type of device. \
A They should be knowledgeable of the potential risks associated with pressurized piping systems. \\ﬁ /
Operators MUST follow all necessary safety procedures. \“\ \}L ‘I‘,%{/Z/,/{

In-line removal Instructions: \‘»E‘g\' ;;f’/\)
1. Depressurize and vent the piping system. ?
2. Drain the system to below sensor level.

3. Wear safety goggles or face shield during removal.
Use all appropriate eye, face, hand, body and/or respiratory protection when working with chemicals or solvents.
4. Place a Lockout tag on the pipe when the sensor is removed for maintenance to prevent accidental opening and
exposure to potentially hazardous chemicals.
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Calibration

pH Calibration Procedure

1.

2.
3.
4

© N

10.
1.

Rinse the sensor off in the rinse water cup. Gently pat dry with a soft, dry cloth or tissue. Warning: Do not let the rinse
water drip into the buffer solution; this will dilute the solution and may change the buffer values.
Place the pH sensor in the first buffer solution (pH 7). Wait until the output from the sensor is stable on the instrument display.
Follow the instrument’s instructions regarding buffer recognition.
Rinse the sensor with water. Warning: Do not let the rinse water drip into the buffer solution; this will dilute the
solution and may change the buffer values.
Dry the sensor gently by patting it with a dry, clean cloth or tissue.
Place the sensor in a cup containing the second buffer solution (pH 4 or pH 10). The second solution used will depend on
the typical pH value of the application.

« If the process value is below pH 7, then use a pH 4 buffer solution.

» pH 10 buffer solution is used when the typical process value is above 7 pH; however, pH 4 buffer is sufficient if pH 10

buffer is not available.

Wait until the output from the sensor is stable.
Follow the instructions in the instrument manual regarding buffer recognition.
Rinse the sensor with water. Warning: Do not let the rinse water drip into the buffer solution; this will dilute the
solution and may change the buffer values.
Dry the sensor gently by patting it with a dry, clean cloth or tissue.
If the calibration was successful, put the sensor back on-line. If it was not successful, clean the sensor and recalibrate.
If the sensor cannot be calibrated, the electrode may need to be replaced.

Calibration Tips

1.

The pH buffer solutions can be used for calibrating more than one sensor within a day. However, the solutions must remain
free of debris and must not be diluted by rinse water from previous calibrations.
Note: Use fresh buffer solutions for best results.

2. Tap or deionized water may be used to rinse the electrodes between each buffer solution.

3. Calibration solutions change value with varying temperature. Allow both the sensor and buffers to equalize with the ambient
temperature. Sensors will not calibrate properly if the sensor is not at ambient temperature. Take note of all temperature
variations of the sensors and the calibration solutions.

4. Do not pour used buffer solutions back into the bottle; dilute with plenty of water and flush them down the drain.

5. Store electrodes in pH 4 buffer when not in use.

6. Calibrate sensors on a regular basis.

7. If the pH sensor does not calibrate within acceptable limits, clean the electrode and calibrate again. If the sensor continues
to calibrate outside of acceptable limits, the electrode is spent and must be discarded.

8. Acceptable pH ranges during calibration are as follows:

pH7: High: 78pH= -50mV; Low: 6.2pH= 50mV
pH 4: High: 48pH= 227mV; Low: 3.2pH= 127 mV
pH 10: High: 10.8 pH=-227 mV; Low: 9.2 pH=-127 mV
Electrochemical pH vs. mV Ratio Theoretical mV Values @ 25 °C
» The mV output from the electrode is created by the interaction of the
electrode and the fluid. The electrode contains a gel that depletes pH mV
over time, so the instrument must be readjusted periodically to 2 +295.8 mV
maintain system accuracy. The need for recalibration varies with each 3 +236.64 mV
application, but the life of the electrode is usually consistent. 4 +177.48 mV
» Keep a maintenance log to establish a depletion trend in new systems. -
« The mV calibration is a two-point procedure. Signet offers pH buffer 5 +118.32 mV
solutions prepared specifically for this purpose. 6 +59.16 mV

» pH buffer solutions can be used for calibrating more than one sensor 7 0mv

within a day provided that the solutions are protected from debris and
are not diluted by rinse water from the calibration procedure. 8 -59.16 mV

 Use clean water to rinse buffer solutions from the electrode. 9 -118.32 mV

» Dispose of all buffer solutions at the end of the day. 10 177.48 mV

« If the pH sensor will not calibrate within acceptable limits, clean the 1 236.64 mV

electrode and recalibrate. If the calibration results remain outside of :
acceptable limits, the sensor is depleted and must be discarded. 12 -295.8 mV

. Fpllow ’Fhe guidelines gf local waste disposal regulations when Electrode slope is the ratio of mV to pH units.

discarding buffer solutions and spent electrodes. At 25 °C the theoretical slope is 59.16 mV per pH.
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Appendix

Maintenance - 463X Chlorine Analyzer Flow Cell

Sensor Removal

CAUTION: Over time, a sensor can get tight in the flow cell fitting. When removing the sensor, avoid
hitting the sensor electronics on the bottom of the wiring enclosure if the sensor suddenly releases.
Take care not to damage the components.

While holding the flow cell, grasp the yellow electronics as a whole unit and
carefully pull upwards, gently rocking back and forth if necessary. Once the
sensor is loose, disengage the electronics, then remove the sensor.

TIP: A tool can be used to carefully pry the sensor electronics up and out if it is
difficult to remove.

Under certain conditions, a dirty flow cell and filter can create a chlorine demand T
which could lower the chlorine concentration in the water flowing past the

chlorine sensor. It is recommended to clean the filter and flow cell on a regular
basis. The frequency of necessary cleaning will depend on the application in
which the system is being used and the level of accuracy required.

Figure 1

Cleaning Z =
Service the flow cell on a clean, dirt free surface = =
to avoid scratches or damage to the flow cell. = =T
e N
Step 1. Keep the system powered on.
Step 2. Disable the relays and any output loops.

Step 3. Turn off the water flow.

Step 4. Remove the sensors from the flow cell. NOTE: It is not _ 3 =
necessary to remove the electronics from the sensor. [ l

Step 5. Install the vinyl caps on to the sensor tips or place the tips of
the removed sensors in a cup of sample water for temporary
storage while cleaning the flow cell.

/A Keep the sensor tips wet and the sensors energized. Figure 2

Step 6. Remove the flow cell from the panel by removing the
knurled nuts (Figure 1).

Step 7. Remove the remaining hardware from the flow cell.
(Figure 2).

NOTE: It is recommended that an anti-seizing compound appropriate for the
application be used during the reassembling of the flow cell.

* Wash the surfaces with plain or soapy water only.

A * Use gentle, liquid dishwashing soap if necessary. Remove filter »
* DO NOT USE commercial glass cleaning fluids. screen to clean.
* Use a soft, lint-free cloth. If the filter is not

desired, it may
be removed from

Servicing the Flow Regulator and Filter the system.

WARNING: Do not disassemble the flow regulator.
There are no user serviceable parts inside.

Flow Regulator
If your inlet pressure is less than 1 bar (15 psi), remove

the flow regulator and quick disconnect inlet connector.
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Appendix

0O-Ring Installation

A

CAUTION! The 3-4630.390 (159 001 688) O-ring kit
comes complete with two O-rings (5 and 6) and a
single cord of material that must be cut and fitted

into the O-ring groove of the flow cell (1 and 4). 1

» The sealing of the flow cell is accomplished by four cut O-ring segments 2 —

and two round O-rings sealing the flow regulator. Refer to the illustration
below for special O-ring fitting instructions. Butt all O-ring joints together
so there is no gap.

* Remove the O-rings during flow cell disassembly. Both the O-rings and all
sealing grooves should be examined for cleanliness.

» Wipe all surfaces carefully with a soft, lint-free cloth to ensure good sealing.

» The cross section of the O-rings should be round and smooth. If they are
flattened, their ability to seal is reduced.

» Do not use liquid or paste sealant.

A\

Do not scratch the sealing surfaces of the flow cell block.
Scratches to the sealing surfaces can cause irreparable leaks.

e

Individual O-rings shown.
Butt all segment joints together in final assembly.

Fit all O-ring joints so there is no gap in final assembly.

New O-ring Old flattened O-ring
cross section cross section
(Replace)
—_——

Butt ends together

Angle cut O-ring
Fit flush with no gap

f

Fit flush with no gap
Straight cut

Straight cut

Angle cut O-ring
Fit flush with no gap
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Appendix

Flow Cell Assembly

WARNING! Do not over tighten flow cell bolts. Maximum torque is 8.1 Nm (72 Lb-In).
Over tightening the bolts can damage the flow cell.
Do not over-tighten the bolts in an attempt to stop a leak.

— E—

i
m\ii0

Install the assembled pressure
regulator and the two round
O-rings into the flow cell.

5 Install the nut and washers.

- = =
Tighten bolts in 3 passes
o @ 4 o]

A
;ﬂr?\ll:: 6 Tighten the nut just enough to hold
(72 Lb-In) the block together and keep the

MAX! O-rings in place.

@_\

1na

2
© <«
6@ = = =
== = =
— = [=-] =
@5 @3 o] @
Tighten the bolts in three passes to

4 Align and place the back block onto specification.
the flow cell. Check to be sure that A
the O-rings are seated correctly.

7 Install the remaining bolts, washers
and nuts.

_

9 Install the flow cell on the panel.
Screw on the thumb nuts finger tight.
DO NOT use tools on the thumb nuts.

NOTE: It is recommended that an anti-seizing compound appropriate for
the application be used during the reassembling of the flow cell.
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Appendix

Maintenance - 2630 Free Chlorine Electrode
Maintenance - 2632 Chlorine Dioxide Electrode

It is required to calibrate the sensor after servicing the
membrane and electrolyte. See Page 24.

Verifying the sensors accuracy using the DPD method

should be performed to determine if the sensor requires

maintenance.

1. Inspect the membrane for dirt or damage. Replace the
membrane if its torn or if the gold cathode is visible.

2. If the membrane is dirty clean the membrane by soaking it

in 1-5% HCL and gently washed with a stream of DI water.
(do not use any mechanical device on the membrane)

Refill Procedure:
When adding electrolyte, be prepared for an accidental spill.
Working near a sink is recommended.

1. Remove the membrane cap from the front of the sensor.

2. Turn the sensor upside down and shake the sensor
vigorously to remove the internal electrolyte.

3. Fill supplied syringe with electrolyte solution.
Additional caution should be taken when handling Chlorine
Dioxide electrolyte solution.

4. Place the electrode on a level surface.

5. Insert syringe needle fully into one of the eight electrode
holes while injecting with electrolyte solution. Slowly
injecting the electrolyte solution into the sensor to avoid
introducing air bubbles. The electrode holds
approximately 14 milliliters of solution. Slowly fill until
solution begins to flow out of holes. Do not allow the
solution to run down the electrode and wet the electrical
contacts in the DryLoc connector.

6. Slowly screw on the membrane cap finger tight.

Do not use tools.
To avoid damage and contamination, do not touch
the white membrane surface on the membrane cap.

Storage

If the sensor or panel assembly is to be removed from
service for a period of time the sensor must be properly
prepared for storage and may need to be recommissioned.

Storage Periods:

1 week or less:

* Close the drain valve, then close the inlet valve of the
flow cell, to maintain water inside the flow cell to keep
the membrane wet.

» If draining the flow cell is required, remove the sensor
from the cell and the 2650 electronics and store in the
shipping bottle with tap water added.

Continue to Page 37 for additional storage periods

Diluted HCI can irritate the eyes and skin,
A use proper safety equipment.

Do not use surface tension reducing chemicals,

detergents or solvents on the membrane.

« |f a fresh water rinse does not clean the membrane,

it will need to be replaced.

» Keep spare membrane caps available.

Membrane caps carry no warranty.

Avoid skin or eye contact with electrolyte

solution. Wear rubber gloves and goggles.

* Material Safety Data Sheets (MSDS) are
available online at www.gfsignet.com.

CAUTION:
DO NOT touch the gold tip or
the membrane of the sensor.

Store electrode between -10 °C to 60 °C
(-4 °F to 140 °F) at a relative humidity that
does not exceed 95%.

The primary concerns when storing the
DO NOT | electrode is membrane dehydration and

FREEZE

freezing in extremely cold environments.
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Appendix

Storage of sensor

* Remove the membrane cap and internal electrolyte
solution.

* Rinse the sensor internal chamber with DI water or cold
tap water; drain and allow to dry.

* Place the membrane cap back onto the sensor. INSTALL
LOOSE, DO NOT COMPLETELY TIGHTEN THE CAP.
WHEN STORED DRY, THE MEMBRANE CAP MUST BE
STORED RELAXED AND UNSTRESSED.

« Store sensor DRY in the shipping bottle,

DO NOT ADD WATER.

Storage Periods Greater than 1 week.,
but less than 2 months:

Recommissioning Procedure:

1. Fill the sensor with the electrolyte as outlined in
Maintenance, Page 36, and install the membrane cap.

2. The sensor will have to be polarized in the flow cell with
flowing Chlorinated water before being used.
Note: This may take 30 to 120 minutes before calibration
can be performed.

3. If the sensor does not recover after recommission, follow
steps 1-10 outlined under Storage periods greater than
2 months.

4. If the sensor still fails to work properly, continue with
steps 11-17.

CAUTION!
Bleach and Chlorine Dioxide solutions are very
corrosive and may release dangerous gases if it
comes in contact with acids.
» Wear proper protective clothing (gloves and eye protection)
* Avoid contact with skin and eyes

» Observe all warnings on safety data sheets
* Avoid spilling bleach and possible contact with acids

N
E

Curved Surface

A=

3

Figure 1

Figure 2

Storage periods greater than 2 months:

» If the sensor has been in storage for a long period of
time, or used in a chlorine free environment, the sensor
may develop a low slope (output), which may cause the
sensor to have a slow response time.

* In this case, the sensor must be reconditioned.

Required to recondition a sensor:
* DI Water
» Beaker (any size available)
* Polishing Sheets (Included in sensor maintenance kit)
 Free Chlorine: Chlorine Bleach (13% concentration)
 Chlorine Dioxide: Aqueous Chlorine Dioxide solution

Reconditioning Procedure:

1. Remove the sensor from the 2750-7 electronics.

2. Remove the membrane cap.

3. Place the sensor on a firm flat surface with the gold
cathode pointing upward.

4. Apply a small amount of water to the Blue (Coarse)
polishing paper (dull side).

5. Polish the gold electrode by moving the paper in a

circular pattern for 10 seconds. DO NOT go back and

forth in a single direction. See Figure 1.

Rinse the sensor tip with DI water.

Apply a small amount of DI water to the White

(Fine) polishing paper (dull side) and polish the gold

electrode by moving the paper in a circular pattern

40-60 seconds. DO NOT go back and forth in a single

direction. See figure 1.

Rinse the sensor tip with DI water.

Top off the sensor with electrolyte and inspect

membrane for dirt or damage. Replace if necessary.

10. Insert the sensor into the 2650 electronics and
apply power.

No

© ©

11. Fill beaker with a 12 mm (%2 inch) of the appropriate solution.

12. Position or suspend the sensor 0.2 mm to 12 mm
(Yain. to Y2 in.) above the appropriate solution.

See Figure 2. DO NOT SUBMERGE THE SENSOR.

13. Apply power to the system.

14. Monitor the nA of the sensor (press the down arrow
once on the 8630 transmitter). The nA reading should
start to rise. Response time and nA reading will depend
upon the temperature of the appropriate solution.

15. Once the sensor's nA reading reaches approximately
300-360 nA allow the sensor to remain in the beaker,
suspended over the appropriate solution, for an
additional 20 minutes.

« If sensor does not recover quickly, cover the
beaker to avoid air contamination.

» Contact the factory for assistance (www.gfsignet.com).

16. After 20 minutes, remove the sensor and install it into
the flow cell and restore flow to the system.

17. Calibrate the sensor after the system has become stable.

+GF+
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Maintenance - 2724 DryLoc® pH Electrode

Electrode Care and Application
pH electrodes are similar to batteries; they age with time and usage. The following information will help maximize electrode life.

General Tips:

» To ensure uninterrupted operation of critical pH systems, replacement electrodes should be available.

» Store boxed electrodes flat or upright (electrode tip down) to maximize hydration of the glass surface.

» Keep the glass surface wet at all times.

» Soak the sensor tip in pH 4.0 buffer during system maintenance intervals.

« If the sensor dehydrates, soak the sensor tip in pH 4 buffer for 24 to 48 hours, then visually inspect the electrode for surface
cracks, swelling, or discoloration.

» It may not be possible to restore severely dehydrated electrodes to normal operation.

» High temperatures, strong acids or caustics will increase electrochemical reactions and speed electrode aging.

» Coatings (e.g. grease) on the glass or junction surfaces cause extended response time and inaccurate measurement.

» Never store the electrode tip in deionized (DI) water. Use pH 4 buffer solution to keep the glass wet when out of the process.

* Never store the electrode at temperatures below 0 °C (32 °F) or allow it to dehydrate.

» Never scrape or sand the glass electrode surface.

» Treat glass electrode surfaces with care to prevent accidental breakage.

Cleaning
Problem Suggested Solution

Use a dilute acid solution (HCI solution of 5% or less). If the electrode has been used in applications
with a pH value higher than 7 pH, soak the electrode for 2 to 5 minutes.

Hard Coatings Use a dilute alkaline solution (NaOH solution at 5% or less) if the electrode has been used in
applications with pH values less than 7 pH, soak the electrode for 2 to 5 minutes.
Alternating immersion in acidic and alkaline solutions may be necessary for thorough cleaning.

Soft Coatings Spray or vigorously stir the electrode with a mild detergent, such as dishwashing liquid. Chlorine

bleach can also be used.

. . . Spray or vigorously stir the electrode with a mild detergent or an appropriate solvent that will not

Oily or Organic Coatings . L S
attack the materials of construction (isopropyl alcohol or similar).

Always rinse the electrode with water after cleaning.

After Cleaning

Soak the electrode in a pH 4 buffer (with KCI if available) for at least 10 minutes after cleaning.
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Problem

No water flow

Low water flow

Excessive flow
Flow cell leaks

Leaks around sensor
Water leaks out of top vent hole

Algae growth in flow cell

Excessive small bubbles in flow
cell accumulating on sensors

Transmitter does not turn on

Chlorine reading too high

Chlorine reading too low

Sensor output drifts

Troubleshooting - 463X Chlorine Analyzer

Possible Cause
Inlet pressure below 1 bar (15 psi)
Damaged flow regulator
Clogged filter
Clogged filter
Insufficient inlet pressure

Damaged flow regulator

Excessive pressure over 8 bar (120 psi)

Damaged flow regulator
Incorrect assembly

Loose bolts

Defective or missing O-rings
Damaged sealing surfaces
Damaged sensor O-ring
Damaged flow cell

Drain valve closed or plugged
Hose connections are backwards
Outlet drain not below flow cell
Low chlorine concentration in water
Exposure to light

Water source contains bubbles

Water source is saturated with
dissolved gasses

No power or external circuit breaker is
switched off

Loose or incorrect wire connections

Open loop wiring or missing jumper
wire on terminal 1 (Loop 1) on the
wiring enclosure terminal block

Breached membrane

Electrode needs to be repolished
Not enough electrolyte

Low flow rate

Filter clogged
Sensor conditioning not long enough

Electrode needs to be repolished
Not enough electrolyte

Variable flow rate

Clogged filter

Contaminated fill solution

The troubleshooting table below outlines possible causes and remedies related to the flow cell panel system.
Refer to the respective transmitter and sensor manuals for specific component troubleshooting.

Remedies

Check source pressure. Remove regulator if pressure is
<1 bar/15 psi

Replace flow regulator

Clean filter or remove pressure regulator if inlet pressure is
below 1 bar (15 psi)

Clean filter

Increase inlet pressure to specification or remove flow
regulator

Inspect or replace

Ensure inlet pressure does not exceed 8 bar (120 psi)
Replace flow regulator

Inspect, clean, and reassemble
Tighten bolts (8.1 Nm, 72 Lb-In Max)
Replace O-rings

Replace flow cell

Inspect or replace O-ring

Inspect flow cell

Inspect

Connect water source correctly

Route drain line below flow cell and vented to atmosphere

Locate flow cell away from light

Check water source

Inspect power and wiring connections
Check connections

Replace jumper wire to terminal 1 or connect a loop device
if the jumper wire to terminal 1 is removed

Replace membrane and fill solution

Polish gold electrode

Check electrolyte level

Check source pressure

Clean the filter

Allow the sensor to condition for 4 hours
(See 2630 or 2632 sensor manual for details)

Polish gold electrode
Check electrolyte level
Check flow rate

Clean the filter

Change electrolyte fill solution

Chlorine Electrode Troubleshooting (see 2630-2 or 2632-1 electrode manual: 3-2630.090)
Transmitter Troubleshooting (see 8630-3 transmitter manual: 3-8630.090-3)
pH Electrode Troubleshooting (see 2724 electrode manual: 3-2724.090)
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Troubleshooting - 8630 Chlorine Transmitter

Several factors can cause irregular or incorrect readings. The first thing to check is to verify that the transmitter and
sensors have been installed correctly. The list below outlines possible causes and remedies.

Problem

Transmitter does not turn on.

Display screen is too dark or too dim.

LCD backlight, relays and sensors do not
work.

Incorrect temperature reading.

Display or Current output is erratic.

Output is not zero when electrode is
placed in non-chlorinated water.

4 to 20 mA output is incorrect.

Possible Cause

Incorrect wiring.

No or low voltage supplied to transmitter.
Blown fuse.

Bad wire connections or splices.

Contrast set incorrectly or ambient temperature
is too high.

No power supplied to terminals 1 and 2.

Faulty chlorine sensor.
Bad sensor connection.

Electrical noise interfering with the
measurement.
Sensor malfunction.

Electrode not properly conditioned.
Noise interfering with the measurement.
Calibration incorrect.

4 to 20 mA is not scaled same as Loop device.
Loop device is not scaled same as sensor.

Chlorine Sensor Troubleshooting (see 2630 sensor manual)

Incorrect readings

Sensor conditioning time too short.
Membrane cap damaged or contaminated.
Interference from water contaminants.
Low flow rate.

Air bubbles on membrane.

pH outside working range

(See Specifications data).

Low or no electrolyte in sensor.

Membrane cap loose.

Only combined chlorine present when
measuring free chlorine.

Sensor not making good contact with
electronics.

Defective sensor.
No pH compensation being used.

Cl sensor not calibrated.

Remedies

Check wiring, power supply and wiring
connections.
Adjust contrast in Options Menu.

Transmitter requires power to terminals
1,2, 3 and 4.

Check connections or replace sensor.

Ensure system is properly grounded.
See Sensor Troubleshooting.

Condition new sensor for 4 hours. Cap

replacement or electrolyte refill: 2 hours.

Properly ground system.
Replace sensor.

Re-span loop device to match sensor.

Run for 4 hours before calibrating.
Clean or replace cap.

See Specifications data.

Check flow.

Install flow cell vertically with upwards
flow.

Check pH.

Fill sensor with electrolyte.
Inspect/tighten (do not use tools).

Validate with DPD test.

Inspect and reconnect.

Replace.

Manually enter pH value in Options or
calibrate pH sensor.

Calibrate Cl sensor.
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» Poor electrical connection

Error Messages

» User input value is out of range

» Sensor is not connected or detected

Sens Data Error

8630 Transmitter Error Messages

« Temperature error

* Incorrect sensor type chosen in the Options Menu

Problem

Cl sensor data memory error.

Possible Cause

Cl sensor is not connected.
Damaged sensor.

The 8630 error warnings are self-explanatory. An error message can appear under the following circumstances:

» Two calibration points are too close together when calibrating pH or chlorine.

Remedies

Check Cl sensor wiring and
connection.

Perform "Find New Sensor" or
recycle power afterward.

CHK C1 PREAMP

Cl preamp is not detected.

Cl preamp is not connected.
Wrong wiring.
Damaged preamp.

Check preamp and transmitter
wiring.

Perform "Find New Sensor" or
recycle power afterward.

CHK pH PREAMP

pH preamp is not detected.

pH preamp is not connected.
Wrong wiring.
Damaged preamp.

Check preamp and transmitter
wiring.

Perform "Find New Sensor" or
recycle power afterward.

CHK C1 SENSOR

Cl sensor is not detected.

Cl sensor not connected.
Damaged sensor.

Check sensor connection.

CHK pH SENSOR

pH sensor is not detected.

pH sensor is not connected.
Damaged sensor.

Check sensor connection.

Out Of Range
CHECK SENSOR

pH calibration error.

pH values are out of range.

Enter proper values during
calibration.

Standard Too Close
To Slope!

pH standard calibration point
is too close to slope point.

Wrong data is entered. pH
buffer solution used has
value too close to standard
point.

Re-enter correct data.

Use proper buffer solution at
least 2 pH units apart from
slope buffer solution.

Slope Too Close
To Standard!

pH slope calibration point is
too close to standard point.

Wrong data is entered. pH
buffer solution used has
value too close to standard
point.

Re-enter correct data.

Use proper buffer solution at
least 2 pH units apart from
standard buffer solution.

Signal Too Close
To Other Cal Pt

The signal level of Cl for
In-process calibration is too
close to the Zero Cal Point.

The CI solution used for
In-process calibration is too
close to Zero Cal. These two
points must be 1 nA apart.

Use proper solution at least
1 nA apart.

Cl Value Must Be
> = 0.2 ppm

The Cl value entered during
In-process calibration is too
small.

Wrong data is entered. The
value entered must be at
least 0.2 ppm (mgl/l).

Re-enter correct value.

Signal Too High
Must Be =< 10 nA

The signal level during Zero
calibration is too high. Signal
must be equal or less than
10 nA.

The sensor is not stabilized.
The solution used has too
much chlorine.

Wait for sensor stabilization.
Check solution to ensure that
the chlorine level is close to
zero ppm (mg/l).

pH Too High

During In-Process calibration
the pH value is too high and

Must be >= 4

must be greater than or
equal to 4.

Must be =< 9 PH value is too high. must be less than or equal Check pH.
to 9.
During In-process calibration

pH Too Low oH value is too low. the pH value is too lowand | oy o
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Transmitter Error Messages - continued

pH sensor is not detected.

pH sensor is not connected.
Wrong wiring.
Damaged pH sensor.

Check pH sensor connections
or change pH input to Manual in
Options Menu.

CHK pH PREAMP

pH preamp is not detected.

pH preamp is not connected.
Wrong wiring.
Damaged preamp.

Check pH preamp wiring.
Perform a "Find New Sensor" or
recycle power afterward.

FCl= WRONG SENSOR

Wrong sensor is detected.

Different type of sensor is
connected.

Wrong sensor type is selected
under Option Menu.

Use correct sensor type.
Perform a "Find New Sensor" or
recycle power afterward.

Select correct sensor type under
Option Menu.

NOTE: Whenever a new type of Cl Sensor is connected to the preamp, a power recycling is required. Another option is to
perform a "Find New Sensor" under the Option Menu.
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Problem

Troubleshooting - 2630 Free Chlorine Electrode
Troubleshooting - 2632 Chlorine Dioxide Electrode

Possible Causes

Transmitter error messages related to calibration are detailed in the Signet 8630 Chlorine Transmitter operation manual.

Remedies

Sensor cannot be calibrated.

Sensor conditioning time too short

Condition for 4 hours minimum prior to initial
calibration

Chlorine content too low

DPD value must be greater than 0.2 ppm to
calibrate

Low flow rate

Check to make sure flow rate is sufficient

Air bubbles on electrode membrane

Inspect visually. Tap to remove bubbles.
Mount at an angle

Output is lower than DPD test.

Low or no electrolyte in electrode

Fill electrode with electrolyte

Organic chlorination agents present in water

See Specifications data

Surfactants in water

Remove surfactants and replace cap

Membrane cap coated

Clean or replace membrane cap

Membrane cap loose

Tighten or replace membrane cap

pH outside working range.

See Specifications data

Sensor output very low

Electrode needs to be repolished

Polish gold electrode

Not enough electrolyte

Check electrolyte level

Sensor conditioning time too short

Condition for 4 hours minimum prior to initial
calibration

Chlorine content too low

Add chlorine to validate

Only bound chlorine present. No free chlorine

Check for chloramine with appropriate DPD
test

Electrode not making good contact with
electronics

Inspect and reconnect

Unstable output from sensor

Electrode needs to be repolished

Polish gold electrode

Not enough electrolyte

Check electrolyte level

Air bubbles on electrode membrane

Inspect visually. Tap to remove bubbles.
Mount at an angle

Membrane damaged

Replace membrane. Condition sensor for at
least 2 hours and recalibrate.

Electrode not making good contact with
electronics

Inspect and reconnect

Non-sensor problem

Check 3-2650 Electronics connection
to electrode (see 3-2650 manual for

instructions). Make sure connections are dry.

Check instrument hookup

Problem

After completing calibration procedure,
the output values are inaccurate.

Troubleshooting - 2750-7 pH Electronics

Possible Cause

Insufficient time allowed for electrode
stabilization during calibration.

Remedies

Recalibrate, verify that test solutions are
at room temperature and wait at least 30
seconds after placing electrode in solution.

Transmitter Troubleshooting (see 8630-3 transmitter manual: 3-8630.090-3)

pH Electrode Troubleshooting (see 2724 electrode manual: 3-2724.090)
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8630 Chlorine Transmitter

General
Compeatibility:
» Sensors: 3-2630-1 Free Chlorine Sensor 0-2 ppm
3-2630-2 Free Chlorine Sensor 0-5 ppm
3-2630-3 Free Chlorine Sensor 0-20 ppm
3-2632-1 CIO, Electrode, 0-2 ppm
3-2724-00 Flat pH Electrode, 0-14 pH
3-2650-7 Amperometric Electronics

3-2750-7 pH Sensor Electronics

« Electronics:

Materials:

» Case: PBT

» Panel gasket: Neoprene

* Window: Polyurethane-coated polycarbonate

» Keypad: Silicone rubber

» Display: Backlit alphanumeric 2 x 16 dot matrix
Update rate: 1 second
Contrast: User selected, 5 levels

» Keypad: Silicone rubber

Performance

System Operational Ranges/Limits:

» 3-2630-1: Free CI: 0.02 to 2 ppm, pH: 510 8.5
» 3-2630-2: Free CI: 0.05 to 5 ppm, pH: 510 8.5
» 3-2630-3: Free CI: 0.1 to 20 ppm, pH: 510 8.5
* 3-2632-1: ClO,: 0.2 to 2 ppm, pH: 4 to 11

» 3-2724-00: pH: 0 to 14

Cl Temp. Range: 0 °C to 45 °C (32 °F to 113 °F)

Max. Cable Length:
« Digital (S3L): 30 m (100 ft) maximum

* 410 20 mA: 305 m (1000 ft) maximum
Electrical
Input Power: 12 to 24 VDC +10% regulated,

250 mA max current
5VDC £1% @ 25 °C, regulated
(provided by 8630)

Sensor Power:

Input Specifications

* One Digital (SL) input from Free Chlorine or
Chlorine Dioxide sensor

* One Digital (S3L) input from pH sensor

Output Specifications:

» Current Loop (2 loops provided)

* 4 to 20 mA, isolated, adjustable span, reversible with
minimum and maximum endpoint adjustment.

* Ability to use chlorine or temperature as input

» Update Rate: 300 ms

* Max Loop impedance: 50 Q max. @ 12V

325Q max. @ 18V

600 Q max. @ 24 V

Relay Outputs:

* 2 mechanical SPDT contacts with adjustable hysteresis
and programmable High, Low, Off, Pulse or Window range.

» May be disabled if not used

» Max. voltage rating: 5A@ 30 VDC

5A @ 250 VAC, resistive load

» Time delay: Programmable from 0 to 6400 s

Environmental Requirements

» Operating Temperature: -25 °C to 120 °C (-13 °F to 248 °F)
(transmitter only)

-15°C to 80 °C (5 °F to 176 °F)
0 to 95%, non-condensing

2000 m (6562 ft)
NEMA 4X

» Storage Temperature:
* Relative Humidity:

* Maximum Altitude:

* Enclosure:

Standards and Approvals
« CE, UL, CUL, WEEE
* RoHS Compliant
» Manufactured under ISO 9001 for Quality,
ISO 14001 for Environmental Management and
OHSAS 18001 for occupational health and safety.

China RoHS (Go to www.gfsignet.com for details)

Declaration of Conformity according to FCC Part 15
This device complies with Part 15 of the FCC rules.
Operation is subject to the following two conditions:

(1) This device may not cause harmful interference, and,
(2) This device must accept any interference received,
including interference that may cause undesired operation.
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Specifications

2650 DryLoc Amperometric Electronics

General
Compeatibility:
¢ Sensors:

¢ |nstruments:

All Signet Amperometric DryLoc Sensors
Signet 3-8630-3P Chlorine Transmitter

Mounting: DryLoc connection
Materials: PBT
Cable: 4.6 m (15 ft) 3 conductor shielded, 22 AWG

* Max. Length: 30 m (100 ft)

Performance

» Accuracy < 5 nAor 1% of reading, whichever is

greater @ 25 °C over full input range

e Temperature: + 1.0 °C (PT1000) over full operation range
(when calibrated at ambient temperature)

* Update Rate: 500 ms

* Range: + 450 nA

* Resolution: 0.1 nA
Electrical

Input Specifications:

» Sensor: Raw signal

» Temperature: PT1000 RTD

Output Specifications:
* Digital (S%L): Serial ASCII, TTL level 9600 bps

Power Supply Input:
* Digital (S°L): 51t06.5V + 10%, 3 mA max
Environmental
» Storage Temp.:

* Operating Temp.:

-20 °C to 50 °C (-4 °F to 120 °F)

0 °C to 85 °C (32 °F to 185 °F)
(electronics only)

» Relative Humidity: 0 to 95%, non-condensing

(no electrode connected)

NEMA 4X/IP65 with electrode installed
0.64 kg (1.41 1b)

* Enclosure:
» Shipping Weight:

Standards and Approvals
+ CE, WEEE
* RoHS Compliant
* Manufactured under ISO 9001 for Quality,
ISO 14001 for Environmental Management and
OHSAS 18001 for occupational health and safety.
@ China RoHS (Go to www.gfsignet.com for details)

F@ Declaration of Conformity according to FCC Part 15
This device complies with Part 15 of the FCC rules.
Operation is subject to the following two conditions:

(1) This device may not cause harmful interference, and,
(2) This device must accept any interference received,

including interference that may cause undesired operation.

2750-7 pH Electronics

General
Compatibility:
« Electrode:

¢ |nstrument:

Signet 2724-00 Flat pH electrode
Signet 8630-3P Chlorine Transmitter

Mounting: DryLoc connection

Materials: PBT

Cable: 4.6 m (15 ft) 3 conductor shielded, 22 AWG
Performance

» Accuracy: +0.03pH@ 25 °C

* Resolution: 0.02 pH
* Response Time (includes electrode response):
< 6 s for 95% of change

* Range: 0.00 to 14.00 pH
* Resolution: 0.02 pH
Electrical

Input Specifications:

* Input Impedance: >10"Q

* Temperature Drift: + 0.002 pH per °C
e Input Resolution:  0.02 pH, 0.3 °C

Output Specifications:
« Digital (S3L):  Serial ASCII, TTL level 9600 bps

Environmental
» Storage Temp.: -20 °C to 50 °C (-4 °F to 120 °F)
* Operating Temp. (Electronics Only):
0 °C to 85 °C (32 °F to 185 °F)
» Relative Humidity: 0 to 95%, non-condensing
» Enclosure: NEMA 4X/IP65 with electrode installed
« Shipping Weight:  0.64 kg (1.41 Ib)

Standards and Approvals
+ CE, WEEE
* RoHS Compliant
* Manufactured under ISO 9001 for Quality,
ISO 14001 for Environmental Management and
OHSAS 18001 for occupational health and safety.
@ China RoHS (Go to www.gfsignet.com for details)

F@ Declaration of Conformity according to FCC Part 15
This device complies with Part 15 of the FCC rules.
Operation is subject to the following two conditions:

(1) This device may not cause harmful interference, and,
(2) This device must accept any interference received,

including interference that may cause undesired operation.
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2630-X Amperometric Free Chlorine Electrode
2632 Amperometric Chlorine Dioxide Electrode

General
Compatibility:
* Flow Cells:

« Electronics:
Electronics

Mounting:

Materials:

* Housing

*« Membrane:
Free Chlorine:

Chlorine Dioxide:
e O-ring:
« Electrode:

Wetted Materials:

Performance
Electrode:
* Repeatability:

» Slope:
Free Chlorine:
Chlorine Dioxide:
» Response time, T90:

Sensor Conditioning:

Signet 3-3610-1

Signet 3-3610-2

Signet 3-4630.392

Signet 2650 Amperometric

Signet DryLoc connection

CPVC

PVDF (prior to Nov 1, 2012)
PTFE (after Nov 1, 2012)

PTFE

FPM

Gold (working)

Silver halide (counter-reference)
PVC, PVDF, PTFE, FPM, Nylon,
Silicone

+ 0.08 ppm (mg/L) or 3% of selected
range whichever is less

15 to 85 nA/ppm (mg/L) @ 25 °C
40 to 200 nA/ppm (mg/L) @ 17 °C
< 2 minutes

* 4 hours max. before calibration (new/first time start)
* 2 hours max. (subsequent start-ups)

System: (including electronics and instrument)

» Accuracy:
* Resolution:
Temp. Element:

< +3% of electrode signal after calibration
< 0.5% of electrode range
PT1000, Class B with measurement range

of -50 °C to 150 °C (-58 °F to 302 °F)
(measurement only, not operating specification)

Operational Ranges and Limits

» Free Chlorine: 3-2630-1: 0.02 to 2 ppm (mg/L)
3-2630-2: 0.05 to 5 ppm (mg/L)
3-2630-3: 0.1 to 20 ppm (mg/L)

» Free Chlorine pH: 5.0t0 8.5 pH
 Chlorine Dioxide: 3-2632-1: 0 to 2 ppm (mg/L)
» Chlorine Dioxide pH: 4.0to 11.0 pH

Temperature: 0 °C to 45 °C (32 °F to 113 °F)
Maximum Pressure:
* Membrane: 0.48 bar @ 25 °C (7 psi @ 77 °F)
Flow Velocity Across Membrane Surface:

e Minimum: 15 cm/s (0.49 ft/s)

» Maximum: 30 cm/s (0.98 ft/s)

Cross Sensitivity:
* Free Chlorine:
* Chlorine Dioxide:

ClO,, ozone, bromine
FCI, ozone

Chemical
Compatibility: < 50% ethanol/water < 50% glycerol/water

Environmental
Temperature
+ Operating: 0 °C to 45 °C (32 °F to 113 °F)

» Storage (dry): -10°C to 60 °C (-4 °F to 140 °F)

Rel. Humidity: 0 to 95% indoor/outdoor non-condensing

to rated ambient

Shipping Weight: 0.14 kg (0.30 Ib)

Standards and Approvals
« CE, WEEE
* RoHS Compliant
* Manufactured under ISO 9001 for Quality,
@ China RoHS (Go to www.gfsignet.com for details)

FE Declaration of Conformity according to FCC Part 15
This device complies with Part 15 of the FCC rules.
Operation is subject to the following two conditions:

(1) This device may not cause harmful interference, and,
(2) This device must accept any interference received,
including interference that may cause undesired operation.
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Specifications

General
Compatibility:

Process
Connection:

Wetted Materials:

Performance
« Efficiency:

Temperature
» Storage:

» Operating:

Rel. Humidity:

Shipping Weight:

« WEEE

2724 DryLoc pH Electrode

Signet 2750 pH/ORP Sensor electronics

% in. NPT or ISO 7/1 R% threads
or Signet flow fittings

PPS, glass, UHMW PE, FPM

>97% @ 25 °C (77 °F)

Efficiency indicates the "wellness" of a

new electrode. Efficiency is measured by
comparing the actual slope (mV/pH) at 25
°C to the theoretical output of 59.16 mV/pH.
An efficiency of 97% to 100% is equivalent
to a slope of 57.39 to 59.16 mV/pH.

* Range: 0to 14 pH
Environmental
Pressure

» Operating:

-10 °C to 65 °C (14 °F to 149 °F),0 to 6.9 bar (0 to 100 psi)

65 °C to 85 °C (149 °F to 185 °F),
Linearity derated 6.9 to 4.0 bar (100 to 58 psi)

0 °C to 50 °C (32 °F to 120 °F).
CAUTION: The electrode glass will

be shattered if shipped or stored at
temperatures below 0 °C (32 °F).

The performance life of the electrode will
be shortened if stored at temperatures
above 50 °C (120 °F).

-10 °C to 85 °C (14 °F to 185 °F)

0 to 95% indoor/outdoor non-condensing to
rated ambient

0.25 kg (0.55 Ib)

Standards and Approvals

* RoHS Compliant

* Manufactured under ISO 9001 for Quality,
ISO 14001 for Environmental Management and
OHSAS 18001 for occupational health and safety.

@ China RoHS (Go to www.gfsignet.com for details)
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Ordering Information

Mfr. Part No. Code
3-4630-10 159 001 748

3-4630-11 159 001 749
3-4630-20 159 001 691
3-4630-21 159 001 692
3-4630-30 159 001 750
3-4630-31 159 001 751
3-4632-10 159 001 768
3-4632-11 159 001 769
3-8630-3P 159 001 673
3-2630-1 159 001 746
3-2630-2 159 001 662
3-2630-3 159 001 747
3-2632-1 159 001 767
3-2724-00 159 001 545
3-2750-7 159 001 671
3-2650-7 159 001 670

3-4630.390 159 001 688
3-4630.391 159 001 689
3-4630.392 159 001 690
3-4630.393 159 310 162
7300-0024 159 001 693

3-2630.391 159 001 674
3-2632.391 159 310 160
3-2630.392 159 001 675
3-2630.394 159 310 164

3-2630.396 159 001 676

3-2630.398 159 310 166
3-2632.398 159 310 165

1220-0021 159 801 182
3-0700.390 198 864 403
3822-7004 159 001 581
3822-7007 159 001 582
3822-7010 159 001 583
3-2700.395 159 001 605
3-2759 159 000 762
3-2759.391 159 000 764

463X Chlorine Analyzer

Description

Chlorine panel, transmitter, free chlorine sensor (0 to 2 ppm), w/ sensor electronics, no pH sensor

Chlorine panel, transmitter, free chlorine sensor (0 to 2 ppm) w/ sensor electronics, pH sensor w/ electronics
Chlorine panel, transmitter, free chlorine sensor (0 to 5 ppm) w/ sensor electronics, no pH sensor

Chlorine panel, transmitter, free chlorine sensor (0 to 5 ppm) w/ sensor electronics, pH sensor w/ electronics
Chlorine panel, transmitter, free chlorine sensor (0 to 20 ppm), w/ sensor electronics, no pH sensor

Chlorine panel, transmitter, free chlorine sensor (0 to 20 ppm) w/ sensor electronics, pH sensor w/ electronics
Chlorine panel, transmitter, chlorine dioxide sensor (0 to 2 ppm), with sensor electronics, no pH sensor
Chlorine panel, transmitter, chlorine dioxide sensor (0 to 2 ppm), with sensor electronics, pH sensor w/ electronics

Panel mount chlorine and pH transmitter

Free Chlorine electrode, 0 to 2 ppm (mg/L)
Free Chlorine electrode, 0 to 5 ppm (mg/L)
Free Chlorine electrode, 0 to 20 ppm (mg/L)
Chlorine Dioxide electrode, 0 to 2 ppm (mg/L)

Electrode, pH, flat, PT1000, % in. NPT
pH - Inline Electronics, Digital (S°L), 4.6 m (15 ft) cable
Chlorine - Inline Amperometric Electronics, Digital (S°L), 4.6 m (15 ft) cable

Accessories and Replacement Parts

Rebuild kit, O-rings, boots, screws, 1 filter screen

Pressure regulator with 1 spare filter screen

Acrylic flow cell complete with all components and connections
Flow Switch Kit, PP

24 VVDC Power Supply

Free Chlorine electrolyte, 30 mL (2)

Chlorine Dioxide electrolyte, 30 mL (2)

Free Chlorine replacement PVDF membrane (1) (sensors sold prior to Nov 1, 2012)

Free Chlorine and Chlorine Dioxide Replacement PTFE membrane (1) (sensors sold after Nov 1, 2012)

Free Chlorine sensor replacement kit - (2) electrolyte, (2) PVDF membranes, and Polishing Paper

(sensors sold prior to Nov 1, 2012)

Free Chlorine Sensor maintenance kit - (2) electrolyte, (2) PTFE membranes, (2) Silicone Bands, and Polishing
Paper (sensors sold after Nov 1, 2012)

Chlorine Dioxide maintenance kit - (2) electrolyte, (2) PTFE membranes, (2) Silicone Bands, and Polishing Paper

O-ring FPM

pH Buffer Kit (1 each 4, 7, 10 pH buffer in powder form, makes 50 mL of each)

pH 4.01 buffer solution, 1 pint (473 mL) bottle

pH 7.00 buffer solution, 1 pint (473 mL) bottle

pH 10.00 buffer solution, 1 pint (473 mL) bottle

Calibration kit: included 3 polypropylene cups, box used as cup stand, 1 pint pH 4.01, 1 pint pH 7.00
pH/ORP System Tester (adapter cable sold separately)

2759 DryLoc Adapter Cable (for use with 2750 and 2760)
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